
Extending Our Lines
To Your Desktop
User’s Manual – Version 4.0.4



 

 Table of Contents 
 
1	
   Welcome to SAG10 Software ................................................................................... 2	
  

1.1	
   What is SAG10 Software? ............................................................................................2	
  
1.2	
   Who Can Use SAG10 Software? ..................................................................................2	
  
1.3	
   SAG10 Highlights .........................................................................................................2	
  

1.3.1	
   SAG10 Features ........................................................................................................2	
  
1.3.2	
   What’s New in SAG10 Version 4.0? ........................................................................3	
  
1.3.3	
   History of SAG10 Software and the Graphic Method ..............................................4	
  
1.3.4	
   Future Direction for SAG10 Software ......................................................................4	
  

1.4	
   Installation .....................................................................................................................5	
  
1.4.1	
   Southwire’s SAG10 Package Includes: ....................................................................5	
  
1.4.2	
   Minimum System Requirements ...............................................................................5	
  
1.4.3	
   Installing the Application ..........................................................................................5	
  
1.4.4	
   Registering a License ................................................................................................6	
  
1.4.5	
   Troubleshooting ........................................................................................................7	
  
1.4.6	
   Automated Updating .................................................................................................8	
  

1.5	
   Technical Support .........................................................................................................8	
  
2	
   Getting Started with the SAG10 Program ............................................................ 10	
  

2.1	
   Creating a SAG10 Project ...........................................................................................10	
  
2.2	
   Select the Conductor ...................................................................................................11	
  
2.3	
   Enter the Ice/Wind Load and Tension Limits .............................................................12	
  
2.4	
   Enter the Ruling Span Lengths ...................................................................................13	
  
2.5	
   Calculate Sag and Tension ..........................................................................................15	
  

3	
   Main Menu Toolbar Controls ................................................................................ 17	
  
3.1	
   File Menu ....................................................................................................................17	
  

3.1.1	
   New .........................................................................................................................17	
  
3.1.2	
   Open ........................................................................................................................17	
  
3.1.3	
   Save .........................................................................................................................17	
  
3.1.4	
   Save As ...................................................................................................................17	
  
3.1.5	
   Exit ..........................................................................................................................17	
  
3.1.6	
   Exit and Check-In License ......................................................................................17	
  

3.2	
   Run Menu....................................................................................................................17	
  
3.2.1	
   Sag & Tension .........................................................................................................17	
  
3.2.2	
   Pause Between Spans ..............................................................................................18	
  
3.2.3	
   Inclined Spans .........................................................................................................18	
  
3.2.4	
   Ruling Span Calculation .........................................................................................19	
  

3.3	
   Tools – Options Menu ................................................................................................20	
  
3.3.1	
   Elevated Temperature .............................................................................................21	
  
3.3.2	
   Input and Output Tensions ......................................................................................24	
  
3.3.3	
   Optional Columns in Output ...................................................................................26	
  
3.3.4	
   Units ........................................................................................................................26	
  
3.3.5	
   NESC K ..................................................................................................................27	
  
3.3.6	
   Also Output Results to ............................................................................................27	
  
3.3.7	
   Creep (Time Selection) ...........................................................................................27	
  
3.3.8	
   Folder Path Setups ..................................................................................................28	
  



 

3.3.9	
   Stress-Strain Curves ................................................................................................28	
  
3.3.10	
   Send To File ............................................................................................................28	
  
3.3.11	
   Chart Type ..............................................................................................................28	
  

3.4	
   Tools – Chart Explorer ................................................................................................29	
  
3.5	
   Tools – Export PLS-CADD® WIR Files (for Concurrent Licenses Only) .................32	
  
3.6	
   Setup Menu .................................................................................................................32	
  

3.6.1	
   Print Setup ...............................................................................................................32	
  
3.6.2	
   Page Setup ...............................................................................................................32	
  
3.6.3	
   Fonts ........................................................................................................................33	
  

3.7	
   Help Menu ..................................................................................................................33	
  
3.7.1	
   Help→Contents→Function Tabs ............................................................................33	
  
3.7.2	
   Help →Search for Help On … ................................................................................34	
  
3.7.3	
   Help →Tech Support ..............................................................................................34	
  
3.7.4	
   Help →View License ..............................................................................................34	
  
3.7.5	
   Help →About SAG10 [Software] ...........................................................................34	
  
3.7.6	
   Help →Maintenance Agreement ............................................................................35	
  

4	
   Conductor Selection Screen ................................................................................... 37	
  
4.1	
   Conductor Type ..........................................................................................................38	
  
4.2	
   Conductor or Messenger .............................................................................................38	
  
4.3	
   Chart Type ..................................................................................................................39	
  
4.4	
   Data Panel ...................................................................................................................39	
  

4.4.1	
   View Chart ..............................................................................................................40	
  
4.4.2	
   Editing Conductor Data ..........................................................................................40	
  
4.4.3	
   Generating a WIR file (For Concurrent Licenses Only) .........................................41	
  

4.5	
   Conductor Options ......................................................................................................41	
  
4.5.1	
   VR2® (Twisted Pair) Option ...................................................................................41	
  
4.5.2	
   Use as a Messenger .................................................................................................42	
  
4.5.3	
   Non-Supporting Cable, Pre-Assembled or Lashed .................................................43	
  
4.5.4	
   Marker Balls ............................................................................................................44	
  
4.5.5	
   PLP Spoiler .............................................................................................................45	
  
4.5.6	
   ADSS Cable ............................................................................................................47	
  
4.5.7	
   OPGW Cable ..........................................................................................................47	
  
4.5.8	
   AAAC Conductor ...................................................................................................47	
  
4.5.9	
   ACSR/TW Codewords............................................................................................48	
  

4.6	
   Sort Options ................................................................................................................48	
  
5	
   Edit Loading Table Screen ..................................................................................... 50	
  

5.1	
   Load Table Fields .......................................................................................................51	
  
5.2	
   Load Selections ...........................................................................................................51	
  

5.2.1	
   NESC 261.H.1.b .....................................................................................................52	
  
5.2.2	
   NESC 261.H.1.b Exception 1 .................................................................................52	
  
5.2.3	
   RUS 1724E-200 Table 9-3 ......................................................................................53	
  
5.2.4	
   California ................................................................................................................53	
  

5.3	
   Add Gallop Load .........................................................................................................53	
  
5.4	
   Add Creep Load ..........................................................................................................54	
  
5.5	
   Extra Heavy Loads ......................................................................................................54	
  
5.6	
   Use of the Common Point ...........................................................................................55	
  



 

5.7	
   Printing the Load Table ..............................................................................................55	
  
6	
   Sag & Tension Data Screen .................................................................................... 57	
  

6.1	
   Data Screen .................................................................................................................57	
  
6.2	
   Creep Messages in the Data Screen ............................................................................57	
  

6.2.1	
   Extrapolated Curve Message ..................................................................................57	
  
6.2.2	
   Creep Messages and Critical Tension .....................................................................58	
  
6.2.3	
   Loading Limits Table ..............................................................................................58	
  

6.3	
   Data Screen Upper Toolbar Controls ..........................................................................59	
  
6.3.1	
   Action ......................................................................................................................59	
  
6.3.2	
   Edit ..........................................................................................................................59	
  
6.3.3	
   View ........................................................................................................................59	
  
6.3.4	
   Stringing Module ....................................................................................................61	
  
6.3.5	
   Offset Clip Module .................................................................................................62	
  
6.3.6	
   Ruling Span Variation Module ...............................................................................64	
  
6.3.7	
   Gallop Module ........................................................................................................66	
  
6.3.8	
   Clash Module ..........................................................................................................73	
  

6.4	
   Data Screen Lower Toolbar Controls .........................................................................77	
  
6.4.1	
   Return ......................................................................................................................77	
  
6.4.2	
   Print .........................................................................................................................77	
  
6.4.3	
   Save .........................................................................................................................77	
  
6.4.4	
   Copy ........................................................................................................................78	
  
6.4.5	
   Edit ..........................................................................................................................78	
  
6.4.6	
   Explore ....................................................................................................................78	
  

(Outside of the U.S.A.) Consumer End Users Only ...............................................................79	
  
7	
   SAG10 Licensed Program End User License Agreement ................................... 80	
  

7.1	
   Definitions...................................................................................................................80	
  
7.2	
   License(s) ....................................................................................................................81	
  
7.3	
   License Restrictions ....................................................................................................82	
  
7.4	
   Upgrades .....................................................................................................................83	
  
7.5	
   Ownership ...................................................................................................................83	
  
7.6	
   Limited Warranty and Disclaimer ..............................................................................83	
  
7.7	
   Exclusive Remedy ......................................................................................................84	
  
7.8	
   Intellectual Property Indemnification .........................................................................85 
7.9	
   Limitation of Liability .................................................................................................85	
  
7.10	
   Basis of Bargain ..........................................................................................................86	
  
7.11	
   (Outside of the USA) Consumer End Users Only ......................................................86	
  
7.12	
   General Provisions ......................................................................................................86	
  
7.13	
   Third Party Software ...................................................................................................86	
  

8	
   Appendices – Reference Materials ........................................................................ 87	
  
8.1	
   A – Chart Logic ..........................................................................................................88	
  
8.2	
   B – Error Messages .....................................................................................................95	
  
8.3	
   C – Determining Sag-Tension on Single Span, No Original Design ..........................98	
  
8.4	
   D – Determining Sag-Tension on Single Span, Original Design Known .................102	
  

 
 



 

SouthwireTM SAG10® Version 4.0.4 User’s Manual [1] 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 
Welcome to SAG10 Software  

What is SAG10 Software? 
 

Who Can Use SAG10 Software? 
 

SAG10 Highlights 
 

Installation 
 

Technical Support 



 

SouthwireTM SAG10® Version 4.0.4 User’s Manual [2] 

1 Welcome to SAG10 Software 

1.1 What is SAG10 Software?  
Southwire’s SAG10 software is a PC-based program that automates execution of the 
Alcoa Graphic Method of sag-tension calculations for overhead conductors. The Alcoa 
Graphic Method has been the standard for sag and tension calculations for almost 90 
years. SAG10® is a registered trademark of Southwire Company in the United States. 

1.2 Who Can Use SAG10 Software?  
Southwire intends the SAG10 program to be used by qualified engineers and designers 
who have a foundation of knowledge about overhead power transmission and distribution 
lines, and the performance of conductors used in those lines. When using the SAG10 
program, a qualified engineer should review the parameters input for the calculations, and 
the resulting calculated data, and verify that they are correct for the specific application. 

1.3 SAG10 Highlights  

1.3.1 SAG10 Features  
SAG10 calculation features include:  

• Alcoa Graphic Method for Sag and Tension Calculations for ACSR and Other 
Conductors  

• Sag and tension with creep  
• Elevated temperature creep  
• Inclined span calculation  
• Stringing sag calculation 
• Graphic output of galloping ellipses and sag curves  
• Offset clipping calculation  
• Clash module for calculating clearance between conductors and ADSS conductor 
• Galloping calculations 
• Ruling span variation calculations 

 
Other SAG10 features include:  

• Easy-to-use menu-driven interface 
• Create, save, and open project files 
• Automatic creep check 
• Easily create, save, and edit Custom conductors  
• Add attachments and supported loads to conductors 

 
Data furnished includes:  

• Stress-strain coefficients 
• Standard load tables 
• Conductor database including:  

o AAC 
o AAAC 
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o ACAR 
o Hard Drawn Copper  
o ACSR 
o ACSR/AW 
o ACSR/TW 
o ACSR/SD 
o ACSS 
o ACSS/AW 
o ACSS/TW 
o ACCR 
o ACCR/TW 
o Covered Line Wire 
o Multiplex 
o Alumoweld 
o OPGW 
o Copperweld 
o Copperweld-Copper 
o Steel 
o AAC British 
o AAAC British 
o ACSR British 

1.3.2 What’s New in SAG10 Version 4.0?  
• Full Compatibility with the Windows® XP, Windows 7, and Windows 8 operating 

systems, both 32-bit and 64-bit editions. *Windows® is a registered trademark of Microsoft 
Corporation in the United States and other countries. 

• Updated conductor data 
• Automated stress-strain chart selection using logic algorithms 
• Updated U.S./Metric units and conversions 
• Calculation optimization - Rounding only for displayed values, unit conversions 

made only for display) 
• °C/°F unit selection in Edit Loading Table screen 
• °C and °F units in sag-tension reports 
• Automated software and data updates 
• Flexible licensing options 
• Easily export Power Line Systems, Inc. (PLS-CADD®) files. PLS-CADD® is a registered 

trademark of Power Line Systems, Inc. in the United States. 
• Conductor Types in drop-down format and better grouped for easy selection 
• Added loading limits table in reports 
• Corrected VR2® (Twisted Pair) calculations 
• Enhanced Loading Table Editor, including simplified loading limit entry 
• Edit and save Glazed and Rime Ice Densities 
• Updated load tables per the NESC 2012 and RUS 2009 
• Save ADSS conductors to Custom and in project files 
• Improved performance and reliability 
• View graphs of stress-strain charts 
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1.3.3 History of SAG10 Software and the Graphic Method  
The Alcoa Graphic Method of sag-tension calculations was developed in 1926 by H.H. 
Rodee. The Alcoa Graphic Method is based on analysis of the stress-strain behavior of 
the complete conductor and its component parts. The method is useful for composite 
conductors such as ACSR and ACSS, as well as conductors composed of a single metal 
such as aluminum, copper, or steel.  
 
In 1963, a mainframe-based program named SAGTEN became available to automate 
execution of the extensive calculations required by the Alcoa Graphic Method. In 1994, 
developers released the SAG10 program, a PC-based enhancement of the original 
mainframe-based SAGTEN.  
 
In 2008, Southwire Company acquired ownership of the SAG10 program. In Version 
3.10, Southwire completely redesigned the SAG10 user interface to simplify use of the 
program. Southwire also made many other enhancements to improve the accuracy and 
reliability of the SAG10 program. Version 4.0 includes many enhancements, notably the 
Compatibility with all current Windows® operating systems.  

Release History:  
1992, SAG10 Version 5 and SAGPLOT Version 1  
1994, SAG10 Program for Windows  
1997, SAG10 Version 1.1 for Windows  
1998, SAG10 Version 2.0 for Windows 
2001, SAG10 Version 3.0 for Windows 
2008, Southwire’s SAG10 Version 3.10 for Windows 
2013, Southwire’s SAG10 Version 4.0 for Windows 

1.3.4 Future Direction for SAG10 Software 
Southwire is proud to offer the SAG10 program to the Transmission and Distribution 
market, and we are committed to improving and expanding SAG10 usability and benefits. 
In keeping with that commitment, Southwire will periodically update the SAG10 
software with new features, enhancements, and data based on feedback we receive from 
you. These updates will be made available through the automated update feature in 
Version 4.0, supported under the Maintenance Contract. 
 
As a leading innovator in the industry, many Southwire developments have come through 
its partnership with its Transmission and Distribution customers. That’s why we want to 
hear from you to help us grow and improve the SAG10 program even further.  
 
Please visit http://www.sag10.com/ContactUs.htm and tell us what you like, what you 
dislike, and what you would like to see added to future releases. Help us to continue to 
provide you the best sag and tension tool possible. 
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1.4 Installation  

1.4.1 Southwire’s SAG10 Package Includes: 
1. Product Key 
2. Download link 
3. Installation Instructions link 
4. Documentation link 
5. User’s Manual link 
6. Other helpful links 

1.4.2 Minimum System Requirements 
• Pentium 1.2 GHz or greater with at least 128 MB of RAM. 
• The Windows® XP operating system or higher. 
• Hard disk with at least 40 MB of free space (5 MB used by program for file 

storage). 
• VGA or better monitor 

---------------------------------------------------------------------------------------------------------- 
NOTE 

If you are upgrading from a previous version of the SAG10 program, any 
custom conductors and charts will have to be re-entered after installing the 
new version of the SAG10 program. You should print copies of any custom 
data before uninstalling any prior versions of the software that you wish to 
enter into the new version. It was necessary to change the way custom data is 
entered to correct some issues in prior versions of the SAG10 program. 

--------------------------------------------------------------------------------------------------------- 
 

--------------------------------------------------------------------------------------------------------- 
NOTE 

See the Installation Guide included with order delivery for detailed information 
on the installation process. 

--------------------------------------------------------------------------------------------------------- 

1.4.3 Installing the Application 
1. After downloading the SAG10 installer, double click on the 

“SAG10_Installer.msi” file to begin installing the SAG10 software. 
2. At the security prompt click Run or Accept. 
3. Click Next on the “Welcome to the SAG10 Setup Wizard” window. 
4. To continue the installation, read the License Agreement, check “I accept the 

terms in the License Agreement”, and click on Next. 
5. Information will be presented about this version of the SAG10 software. Read it 

and click Next. 
6. By default, the SAG10 program will be installed under the “C:\Program Files 

(x86)\Southwire\SAG10” folder. A different location may be chosen by clicking 
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on the Change button and selecting the preferred folder. Once completed, click 
Next. 

7. A desktop shortcut will be added by default. Click Next to proceed. 
8. To finalize the installation, click Install. 
9. Click Finish. 
10. To launch the SAG10 program, either double-click on the desktop shortcut OR 

navigate to the program by clicking on Start -> All Programs -> Southwire -> 
SAG10 ->SAG10. 

1.4.4 Registering a License 
The first time the SAG10 program is run, a valid product key will need to be entered to 
activate the software. Product keys are sent with order delivery emails after approval of 
orders. If the key cannot be located, call 1-877-797-2410. 
 

1. Enter the Product Key in the space provided. 
2. Choose the License Type as either Network or Standalone. All standard orders 

will be Network licenses. 
3. By default, the License Source will be set to Internet. If a valid internet 

connection is not available, choose the Email option.  
a) If Internet is chosen and proxy service IS NOT, proceed to Step 4 below. 
b) If Internet and proxy service are chosen, check “Use Proxy Service” and 

click on Configure Proxy Service. Enter the proxy server address and click 
Accept. Proceed to Step 4 below. 

c) If Email is chosen, a license will need to be requested.  
i. Begin by checking “I Accept the Licensing Terms”. 

ii. Click Agree  on the License Agreement window that appears. 
iii. Click on the Request button. 
iv. Select a folder to save the license request file (for example a file 

name LicenseRequest.YYYY-MM-DD.xml will be generated). 
v. Click OK. 

vi. A window will appear with instructions on where to e-mail the 
previously generated license request file. 

When the license file is received, load the application and use the Process 
button to apply it to the SAG10 software. Navigate to the folder where the 
license file is located (Ex: test_license.lic) and click Open. If successful, 
proceed to Step 7. 

4. Check “I Accept the License Terms”. 
5. Click Checkout. 
6. A prompt containing the License Agreement will appear. Choose Agree or Do 

NOT Agree. 
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7. Once a license is successfully checked out, the Status section of License 
Information will be updated to say “Licensed” with a GREEN background. 

8. Click Close and the SAG10 software will appear as seen below. 

1.4.5 Troubleshooting 

ERROR: Could not acquire license. FAILED! NO [CONCURRENT] LICENSES 
AVAILABLE. 
Possible issues: 
 (1) A Product Key was entered, but the License Type was selected as Network instead of 
Standalone. 

1. Click the OK button on the error message 
2. Change the License Type from Network to Standalone 
3. Check “I Accept the License Terms” 
4. Click the Checkout button  

(2) There are no available seats. You must wait for a seat to become available, or call 1-
877-797-2410. 

ERROR: Could not acquire license. FAILED! NO [PERMANENT] LICENSES 
AVAILABLE 
Possible issues: 
 (1) A Product Key was entered, but the License Type was selected as Standalone instead 
of Network. 

1. Click the OK button on the error message 
2. Change the License Type from Standalone to Network 
3. Check the box beside “I Accept the License Terms” 
4. Click the Checkout button  

(2) This license has already been registered as Standalone. Call 1-877-797-2410 for 
support. 

ERROR: Could not acquire license. FAILED! INVALID LICENSE HOLDER 
[license #]. 
An incorrect product key has been entered.  Click the OK button and enter a valid 
Product Key. 

ERROR: Could not acquire license. FAILED! MACHINE ALREADY HAS 
ANOTHER TYPE OF LICENSE ASSOCIATED WITH LICENSE CODE [license 
#]. CONTACT TECHNICAL SUPPORT.  
A license has already been registered to this machine. Call 1-877-797-2410. 
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ERROR: Could not checkin license. FAILED! UNABLE TO CHECKIN LICENSE 
(NOT FOUND).  
To resolve, check out the license by going to Help -> View License. Then the license 
may be checked back in. 

ERROR: Could not checkin license. FAILED! ATTEMPTING TO CHECKIN 
LICENSE WITH PERMANENT ACTIVATION.  
A permanent license may not be checked in. Doing so is not necessary, but if this is 
desired, you will need to contact Technical Support at 1-877-797-2410 to have the 
account checked in manually. 

1.4.6 Automated Updating 
If a software or data update is available for SAG10 Version 4.0, you will be prompted to 
incorporate the updates if: (1) you currently hold a maintenance contract and (2) the 
computer you are using is connected to the internet. The process for installing software 
updates will be similar to the installation process. Data updates will be automatic. 

1.5 Technical Support  
See Appendix B: Error Messages for a list of common error messages in the SAG10 
program and explanations for their appearance. For further assistance, contact SAG10 
technical support at 1-877-SWSAG10 (1-877-797-2410) or visit us on the web at 
www.sag10.com/ContactUs.htm.     
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2 Getting Started with the SAG10 Program  

There are five basic steps to creating a sag and tension report.  
Each of these steps has multiple options, and each step may be affected by options you 
select for the entire project.  

• Enter a project title and description, if desired 
• Select the conductor for the project  
• Enter the ice/wind load and tension limits for the project 
• Enter the ruling span lengths 
• Save as a project file 
• Calculate sag and tension  

 
Within some steps, you can either use standard data, or you can edit and save custom 
data.  

2.1 Creating a SAG10 Project   
To begin using the SAG10 program, click on the SAG10 icon. The SAG10 banner will 
display briefly, then the SAG10 Main Menu screen will appear.  
 

 
 

• Enter the project title or number in the Title box. 
• Enter descriptive information in the Description box.  
• You can edit this information at any time. 
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--------------------------------------------------------------------------------------------------------- 

NOTE 
The Tools→Options menu in the SAG10 Main Menu screen toolbar offers many 
important project option choices. For Options details, refer to the section of the 
Main Menu chapter on the Tools – Options menu.  

---------------------------------------------------------------------------------------------------------  

2.2 Select the Conductor  
In the Conductor Selection panel of the Main Menu screen, click on the Select button. 
The Conductor Selection screen will open.  
 

 
 
Select a conductor construction from the Conductor Type drop-down list.  For this 
example, choose ACSR. A list of available ACSR conductors will open in the 
Conductor or Messenger drop-down list. Select a conductor, and data for that conductor 
will automatically be loaded. Buttons in the Data and Conductor Options panels of the 
Conductor Selection screen let you customize conductor construction data to suit your 
application. You can save custom conductor constructions or use and save them only with 
the current project (See below). Any conductor options you select will be saved with the 
project. 
 
When you have completed your conductor selection and any conductor data edits you 
want, click on the Accept button in the Conductor Selection screen to return to the 
Main Menu.  

Conductor Selection Screen Details  
For more details on conductor selection, refer to the chapter on the Conductor Selection 
Screen. 
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2.3 Enter the Ice/Wind Load and Tension Limits 
The Load Selection panel of the Main Menu contains a list of industry-standard load 
configurations. Choosing the NESC 261.H.1.b loading conditions will limit the initial and 
final tensions at conductor temperatures of 0.0°F, 15.0°F, or 30.0°F depending on the 
selected loading district.  Choosing the NESC 261.H.1.b EXCEPTION 1 loading 
conditions will limit the initial and final tensions at a conductor temperature of 60.0°F 
and can be used when self-damping conductors or other vibration control devices are to 
be used, or when a study deems vibration control is not needed.  The RUS 1724E-200 
Table 9-3 loads and tensions are the equivalent to the old REA/Alcoa loads and tensions. 
You can select a standard load table, create a custom load table, or open a saved load 
table. For the purposes of this example, select NESC 261.H.1.b Medium. 
  

 
 
To view or modify a load table, click on the Edit Load Table button in the Load 
Selection panel. The Edit Load Table screen will appear preloaded with any selection 
you have made in the Load Selection panel of the Main Menu. In our example, this 
screen should open preloaded with the NESC 261.H.1.b Medium values since we 
previously selected NESC 261.H.1.b Medium from the Load Selection panel of the 
Main Menu.  
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For the purposes of this example, click on the Accept Loadings button to return to the 
Main Menu. 

Load Selection Details  
For more details on load selection, refer to the Edit Loading Table chapter. 

2.4 Enter the Ruling Span Lengths  
You can enter up to 50 ruling spans in the Ruling Spans panel of the Main Menu.  

• You can enter spans individually  
• You can create a series of spans.  
• Accept each entry by pressing the Enter key. 
• Units are Feet or Meters, depending on the option selected in the SAG10 Main 

Menu toolbar→Tools→Options screen.  
 
For our example, type in a value of 500 feet, and press the Enter key. 
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The buttons in the Ruling Spans panel of the Main Menu let you edit the ruling spans 
list. You can: 

• Insert Span will insert a span above the currently selected span.  
• Delete Span will delete the selected span.  
• Clear Spans will clear all of the spans in the table.  
• Series of Spans opens the Ruling Spans window to create a series of spans.  

 

 
 
To create a list of multiple ruling spans, equally spaced, simply enter a starting span 
length, the length you want to increment the spans by, and an ending span length. Click 
on the Create button, and the table will be filled in. Click on the Accept button, and 
these values will appear in the Ruling Spans table on the Main Menu. 
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2.5 Calculate Sag and Tension  
 

--------------------------------------------------------------------------------------------------------- 
NOTE 

Before calculating sag and tension, be sure to: 
1. Select a conductor 
2. Specify load conditions 
3. Enter a ruling span or spans  

---------------------------------------------------------------------------------------------------------  
 
You can initiate sag and tension calculations in two ways:  

• Click on the Calculate Sag & Tension button at the bottom of the SAG10 Main 
Menu 

• Select Main Menu toolbar→Run→Sag & Tension.  
 
Either way, the SAG10 program will generate a Sag & Tension Data screen that can be 
viewed, saved to a file, or printed. 

Sag and Tension Output Details  
For more details on sag and tension outputs, refer to the Sag & Tension Data Screen 
chapter. 
 

--------------------------------------------------------------------------------------------------------- 
NOTE 

The Tools→Options menu in the toolbar of the SAG10 Main Menu offers many 
important project option choices. For Options details, refer to the section of the 
Main Menu chapter on the Tools – Options menu. 

--------------------------------------------------------------------------------------------------------- 
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3 Main Menu Toolbar Controls 
The Main Menu toolbar is located at the top of the SAG10 Main Menu.  

3.1 File Menu  

3.1.1 New 
Select New to clear all previous project file data. 

3.1.2 Open 
Select Open to browse for an existing project file and open it. Loading a file will clear all 
current project file data.  

3.1.3 Save 
Select Save to save a newly created file, or to save an existing project file. This selection 
is active only after you have selected a conductor, load parameters, and ruling span data. 
Save SAG10 project files with an .s10 extension.  

3.1.4 Save As  
Select Save As to save a project file under a new name. This selection is active only after 
you have selected a conductor, load parameters, and ruling span data. Save SAG10 
project files with a .S10Proj extension. 

3.1.5 Exit 
Select Exit to close the SAG10 program and return to Windows®.  

3.1.6 Exit and Check-In License 
Select Exit and Check-In License in order to close the SAG10 program and check in the 
license seat for use by another user. 

3.2 Run Menu 

3.2.1 Sag & Tension 
The SAG10 Main Menu toolbar→Run→Sag & Tension selection executes the sag and 
tension calculations. Choose this selection only after selecting a conductor, load 
parameters, and ruling span, and any options in the SAG10 Main Menu toolbar 
Tools→Options screen.  

Sag and Tension Output Details  
For more details on sag and tension outputs, refer to the Output Screen chapter. 
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3.2.2 Pause Between Spans 
If you select the Main Menu toolbar→Run→Pause between Spans option, or the 
Pause between Spans checkbox in the Ruling Spans panel of the Main Menu, a Next 
Span option will be displayed in the toolbar of the Sag & Tension Data screen. 
Selecting Next Span will step through the sag and tension calculation for each ruling 
span entered.  
 
If there is only one span to run, then this option does not affect the output.  
 
If you enter a large number of spans and a Warning Message is received during 
calculation that indicates Out of Memory or Output Exceeds Buffer Size, then you may 
have to either: 

• Use the Pause between Spans option, or  
• Reduce the number of ruling spans.  

 
If these messages are displayed, the screen output will be incomplete, but the Print to 
File output will not be affected. 

3.2.3 Inclined Spans 
If you select the Main Menu toolbar→Run→Inclined Spans option, the Inclined Span 
screen will open. 
 

 
 
Stringing sags generated by the graphic-method are for level ground spans and are based 
on the average tension (Pav) of the conductor. There are times when the combination of a 
long span and difference in elevation creates difficulties in sagging conductor.  
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Depending on the span length and difference in elevation, the lowest point of sag may fall 
beyond the lower support (indicated by a negative value for the x-coordinate in the 
Lowest Point box) or the vertical tension at the lower tower may become positive. If 
either of these conditions occurs, this indicates that there may be an up-lift problem at the 
lower support attachment point. To correct this, enter a lower value for the Horizontal 
Tension. 

Sag Calculation Temperature  
The SAG10 Inclined Span option calculates the proper inclined Span Length (SL) and 
average tension (Pav) to be used based on the Horizontal Tension input. Therefore, as 
tension varies with conductor temperature, the sags and clearances resulting from the 
inclined span calculations are only valid at the conductor temperature associated with the 
Horizontal Tension input. For example, if the horizontal tension is an initial tension at 
60.0°F, the resulting sag and clearance values are valid only for the 60.0°F initial 
condition. 

Inclined Span Control Buttons  
• Calculate will re-calculate the inclined catenary after changing any data. 
• DXF will save the inclined catenary as a .DXF file to a location you specify. A 

DXF file can be imported into most CAD programs. Typical uses would be to 
generate a sag template, or to import the sag curve into a drawing containing 
some ground profile for structure spotting. 

• Print will send the inclined span results to the printer. 
• Close will close the Inclined Span screen and return you to the Main Menu 

screen.  

3.2.4 Ruling Span Calculation  
If you select the Main Menu toolbar→Run→Ruling Span Calculation option, the 
Calculate Ruling Span screen will open. This SAG10 utility calculates a ruling span 
from a list of spans. 
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Enter a list of spans within a line section into the table and click on the Calculate button.  
The resulting ruling span calculation shows in the box below the Calculate button. 

Calculate Ruling Spans Control Buttons 
• Append will append the calculated ruling span to the bottom of the ruling span 

list in the Ruling Spans panel of the Main Menu screen.  
• Replace will remove any existing ruling spans from the ruling span list in the 

Ruling Spans panel of the Main Menu screen and replace them with the 
calculated ruling span.  

• Save Span File saves the span file to a location you specify as a .SPN file type.  
• Open Span File retrieves an existing span file.  

 
Saved span lists can also be recalled and used when creating stringing sag tables. For 
more information, refer to the Stringing Module section in the Output Screen Chapter.  

3.3 Tools – Options Menu 
You can adjust key project option settings by selecting Main Menu 
toolbar→Tools→Options. The Option Settings screen will open.  
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Options you set are saved as part of the current project file. When you are finished 
selecting options, you can:  

• Click on the Save as Defaults button, and the selected options will become the 
defaults when you load the program, or  

• Click on the Accept button, which saves your selections for the current session 
only.  

3.3.1 Elevated Temperature 
The Elevated Temperature options are provided for you to include additional non-
recoverable strain due to operation of conductors at elevated temperatures. These options 
should not be used for ACSS conductors, which are designed for high operating 
temperatures. 
 

 

Input  
This option will cause the sag-tension calculations to include the effects of additional 
non-recoverable strain due to operating a conductor at elevated temperatures. The default 
selection for this option is unchecked. When you check the Input box, the Elevated 
Temperature Creep screen opens. When working with elevated temperature 
calculations, the SAG10 program will modify the Load Table before calculating sag and 
tension. For each conductor temperature in the Elevated Creep Table at or above 16.0°C 
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(60.0°F), an additional row will be created in the Load Table with ET in the Usage 
column to designate the row as an Elevated Temperature Point. Conductor temperatures 
less than 16.0°C (60.0°F) will be ignored since they do not contribute to elevated 
temperature creep. 
 

 
 

Enter the total time for which the conductor is expected to experience elevated 
temperatures over the life of the line. Entries are in hours and °C. 
 
Elevated temperature creep is considered for all-aluminum conductors (AAC, AAAC, 
ACAR) and ACSR conductors with less than 7.5% steel by area. 
Elevated temperature creep of ACSRs with more than 7.5% steel by area is less than 
room temperature creep and can be ignored. If you have chosen an ACSR with more than 
7.5% steel, the program will issue a warning message, uncheck the Elevated 
Temperature Input box, and bypass the Elevated Temperature Creep table.  
 
Finally, click on either the Rolled or Cast Rod option, whichever is appropriate for the 
conductor being modeled. Rolled rod tends to creep more than cast rod, so the formulas 
are different. 
 
The sag-tension output will include a pound (#) sign by the elevated temperature rows. 

Output Strain  
This option is considered only if the Elevated Temperature Input box is checked. If 
both boxes are checked, the sag and tension output will include a line of data at the first 
elevated temp creep point, indicating normal creep (Ec) and elevated temperature creep 
(Ecrp). Ec will represent the normal non-recoverable strain seen in the conductor over ten 
years, in parts per million. Ecrp will represent the non-recoverable strain seen in the 
conductor due to operation at elevated temperatures, in parts per million. 
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Creep is a function of time and temperature. The SAG10 program will select the 
time/temperature that will cause the maximum micro-strain increase in elongation and 
convert it to a temperature differential. This means the Ecrp value will not be a sum of 
the micro-strains but simply the micro-strain from one time/temperature case. 
 
For more background on elevated temperature creep, research the following papers: 

• J. R. Harvey, R. E. Larson - Use of Elevated Temperature Creep Data in Sag-
Tension Calculations, IEEE Paper 69 TP 674-PWR. 

• J. R. Harvey, R. E. Larson - Creep Equations of Conductors for Sag-Tension 
Calculations, IEEE Paper C 72 190-2. 

• J. R. Harvey, R. E. Larson - Technique to Include Elevated Temperature Creep in 
Sag-tension Calculations, IEEE T and D Conference and Exposition April 1-9, 
1979. 

• W. B. Zollars - Aluminum Conductor Elevated Temperature Considerations, 
Seminar sponsored by Georgia Power Co., the Aluminum Association, and EPRI 
on the Effects of Elevated Temperature Operation on Overhead Conductors and 
Accessories - May 20, 1986, Atlanta Georgia. 

Aluminum Compression 
ACSR conductors are composed of two materials, steel and 1350-H19 hardened 
aluminum. These materials expand at different rates when heated. The coefficient of 
linear thermal expansion for aluminum is approximately twice that of steel, so as an 
ACSR conductor is heated, the aluminum will attempt to expand more than the steel core. 
Since the aluminum and steel are connected together at various points along the line, the 
steel prevents the aluminum from elongating as much as it wants to. Under these 
conditions, the helical path of the aluminum grows and a compressive force builds in the 
aluminum, similar to a compressed spring. 
 
This is not a problem in the normal operating temperature range of ACSR, which is 
below 100°C. However, at elevated operating temperatures, the amount of growth in the 
aluminum is much more than the growth in the steel. Since they are connected together, 
the aluminum “spring” pushes against the steel core as it grows. This extra force on the 
steel is not part of the normal sag and tension calculations. It causes the steel to elongate 
more, and thus the conductor to sag more, than the standard calculations predict. 
Selecting the Aluminum Compression option will cause the SAG10 program to take 
into consideration the additional expansive force imparted to the steel by the aluminum. 
 
This option will cause the Aluminum Compression Variables screen to appear. 
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The screen will automatically populate the input boxes with values from the database. 
These values may be edited if needed. 
 
The Built in Aluminum Stress has a default value of 1500 psi. This is the stress from the 
aluminum compression acting on the steel core. 
 
The Aluminum Area is the ratio of the aluminum area to the total area. 
 
The # of Aluminum Layers, # of Aluminum Strands, and # of Core Strands may be 
changed if the data is incorrect. 
 
The Stranding Lay Ratios are the lay ratios (lay length divided by layer diameter) of the 
layers of aluminum. The input boxes go from the Outer Layer to the Inner Layer 
starting left and proceeding right. 
 
Note: This only applies to ACSR and ACCR conductors. This is not an issue in ACSS 
conductors due to the use of fully annealed 1350-O aluminum, which yields more readily 
than hardened 1350-H19 aluminum. For this reason, compressive forces do not build in 
the aluminum to a level high enough to affect the steel core. 
 
For details, refer to “Theory of Compressive Stress in Aluminum of ACSR” and “Some 
Effects of Mill Practice on the Stress Strain Behavior of ACSR” by C. B. Rawlins. The 
Rawlins paper attributes the additional sag at high temperatures in ACSR to mill 
practices. Regardless of the cause, compressive stress is created in ACSR that causes 
additional sag. 

3.3.2 Input and Output Tensions  
A tension value may mean several things. It can describe horizontal tensions, total 
tensions (tension magnitude at support points) or average tensions (an in-between value 
representing the tension state of the entire span).  
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When you fill in the Load Table, you may require a limit based on a particular tension 
type. Conversely, in the sag and tension data output, you may want to display a different 
type of tension. The SAG10 program lets you specify input and output tension types 
separately in the Input Tensions and Output Tensions panels of the Options Settings 
window. In addition, the Output Tensions panel has a box that lets you select a display 
that separates the tension components attributed to steel and aluminum. (See below for 
details.)  

Average Tension 
The default used for tension is the average value.  

Horizontal Tension (At Sag)  
The horizontal tension is at the belly of the sag. At this point, the horizontal tension 
equals the total tension in the conductor. Horizontal tension is used in offset clipping and 
inclined span calculations. Formulas used for level spans are as follows: 
 
 TH = 2Tavg - TS 
 
Where: TH = Horizontal, lb 
 Tavg = Average tension, lb 
 TS = Total tension (at supports), lb 

Total Tension (At Supports)  
The total tension is the total tension at the supports. It includes the weight of the wire. 
The tension at the supports is used in tower-design calculations. Formulas used for level 
spans are as follows: 
 
 TS = TH + wD 
 
Where TS = Total tension at supports, lb  

w = Conductor weight, lb/ft 
 D = Conductor sag, ft 

Separate Aluminum and Core Tension  
The basis for the Alcoa Graphic Method of sag and tension is stress-strain testing. When 
stress-strain tests are performed on steel core conductors, both composite (aluminum 
combined with steel) and single (that of the steel only) data are generated. When dealing 
with steel core conductors, the Graphic Method derives the stress-strain data of the 
aluminum portion by subtracting the available steel data from that of the composite.  
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At each conductor temperature specified in the Load Table, the calculations are 
performed using the stress-strain data from the components, which are then added to form 
the composite. The Separate Aluminum and Core Tensions option will cause the 
tensions in each of the components to be displayed, as well as the total tension in the 
conductor. The ability to view the separate tensions can be a valuable tool when 
evaluating operation of ACSRs at high temperatures, or when calculation pre-tensioning 
for ACSS conductors.  

3.3.3 Optional Columns in Output  
These option boxes add columns to the sag and tension output for final and initial tension.  
 

 
 

• None – no added columns  
• % RBS – Percentage of Rated Breaking Strength 
• H/W – Horizontal Tension divided by Weight. This is often referred to as the 

“Catenary Constant” or “C” value 
• Horizontal and Vertical Sag – displays the resultant sag as horizontal and 

vertical components 

3.3.4 Units  
There are four options available for Units:  
 

 
 

• U.S./Imperial - Both the input and output are in pounds per foot, pounds, and feet 
• U.S./Imperial to Metric/kN - U.S./Imperial input and Metric/kN output in 

Newtons per meter, Kilonewtons, and meters 
• Metric/kN - Both input and output are in Newtons per meter, Kilonewtons, and 

meters 
• Metric/kg - Both input and output are in Kilograms per meter, Kilograms, and 

meters 
 
All bare overhead conductor designs, including calculations of weight and RBS, are per 
ASTM International, regardless of the unit selection made. CSA and IEC designs are not 
currently supported. See the chapter on Editing conductor data for information on how 
to edit the data in order to conform to other standards. 
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NOTE: If you have any information on ways to improve our Metric use, please contact us 
via the SAG10 website. 

3.3.5 NESC K 
Occasionally it is necessary to distinguish between NESC 5th or 6th Edition and the 
rounded-off K factor of the NESC 7th Edition.  
 

 
 

• New – Designates NESC 7th edition 
• Old – Designates NESC 5th or 6th edition  
• Old (Steel and Cu) – Match calculations for steel or copper cable for the older 

NESC manuals  
• Zero - Ignore K  

3.3.6 Also Output Results to 

Default Printer 
Automatically sends the results shown in the sag and tension calculation output screen to 
the default printer specified in the Print Setup section of this manual.  

File 
Automatically sends the results shown in the sag and tension calculation output screen to 
a specified file. The SAG10 program will prompt you for a file name to save the output 
when you run the sag and tension calculation. 

3.3.7 Creep (Time Selection) 
THIS FEATURE IS BROKEN AND WILL BE FIXED IN AN UPDATE. 
 
The SAG10 program calculates final sag and tension data assuming 10 years of 
conductor creep. 
 

                                          
 
Entering a number in Creep Time at Stress (Days) lets you calculate the conductor creep 
that would result from a longer or shorter time period. A shorter time period may be 
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helpful in evaluating conductors that have been under tension less than 10 years. A longer 
time period may be helpful to see if any additional creep may occur past 10 years. Blank 
or “0” will default to 10 years. 

3.3.8 Folder Path Setups 

Conductor Data  
Browse or specify a path to a default folder containing conductor data.  

Project Files 
Browse or specify a path to a default folder containing project file data.  

3.3.9 Stress-Strain Curves 
Typically, the SAG10 program uses the full stress strain curves. These return the stress 
level at ANY strain value as calculated using the polynomial coefficients from the stress-
strain charts.  The default for this option is Use Full Curves and Southwire recommends 
that you do not change this.  The Threshold Strain is now set to 0.5%. 
 
There are times, especially when large mechanical loadings are placed on a conductor, 
particularly in longer spans, that very large strains are encountered. The SAG10 program 
may have to estimate, to the best of its ability, the stress-strain curve in these situations to 
complete the calculation. However, you should be aware that this is occurring as it may 
affect the accuracy of the results.  If this occurs, a message will display on your output 
indicating that the calculations used an extrapolated curve. 
 

 

3.3.10 Send To File 

Overwrite 
When you check this box, the data sent to a specified file will overwrite the existing data.  

Append to Existing File 
When you check this box, the data sent to a specified file will be appended to the existing 
data.  

3.3.11 Chart Type 
This drop-down lets you select a default stress-strain chart type. The options are: 

• Legacy – This is historical data based on averages of older individual stress-strain 
test data and calculated data. Stress-strain tests run on these conductors were built 
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using various standards. Therefore, your conductor manufacturer should be 
consulted for stress-strain data that is representative of your conductor. 

• Southwire – This option will become available as Southwire releases verified 
stress-strain data. Southwire has instituted a stress-strain testing program in order 
to provide optimal data for the SAG10 software. 

• Manufacturer Verified – This option is for charts representing conductor types not 
manufactured by Southwire. These charts have been verified as representative of 
the conductor by the manufacturer specified under the chart number. 

• Custom – These charts are custom selections by the user. A custom chart could 
include any chart from the Chart Explorer database or one added by the user. If 
the chart selected logically by the SAG10 program is changed, it becomes a 
Custom selection. 

3.4 Tools – Chart Explorer 
The stress-strain chart database is comprised of legacy charts which are the culmination 
of historical data based on averages of older individual stress-strain test and calculated 
data. Since a single stress-strain test cannot be concluded as accurate and representative 
of a conductor, many of the charts are the average of multiple tests. As new data becomes 
available by way of testing at Southwire, new charts will be added to the database that 
will be representative of Southwire conductor. 
 
Selecting Main Menu toolbar→Tools→Chart Explorer will open the Chart Explorer 
screen. This screen shows a list of conductor detail charts, sorted by chart number. 
 

 
 
The chart explorer lets you quickly view any available charts, including those you create.  
Charts that are Locked cannot be edited. 
 
Add 
The Add button allows you to create a custom chart.  Clicking on this button will open a 
blank Chart Details screen for you to fill in. 
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The Chart Code should be a custom chart number, either 6-### or 6-####. 
 
The Ref. Temp. should be the conductor temperature measured during stress-strain 
testing. 
 
The Outer Area Fraction is the percent by area of the outer material. 
 
The Cable Class is the conductor type. 
 
The Chart Coefficients should be filled in using the 4th Order Polynomials gathered 
from stress-strain testing. The Initial K0-K4 values should be representative of the initial 
curve with 1-hour creep, in units of psi/100. The Creep K0-K4 values should represent 
the initial curve with 10-year creep added, in units of psi/100. The last column has boxes 
for Elasticity and Thermal. The Elasticity is the final modulus of elasticity, in units of 
psi/100. The Thermal is the thermal coefficient of expansion, in units of %/°F. The Outer 
Components and Core Components will need to be added for steel or composite core 
conductors. Only the Outer Components will be needed for homogeneous conductors. 
 
The Stranding Information is optional and will only be used for Aluminum 
Compression calculations. See the section on Aluminum Compression for more 
information. 
 
Delete 
This will delete the currently selected chart from the database. 
 
Details 
This will open the Chart Details screen for the selected chart. 
 
If you select a chart in the Chart Explorer screen and click on the Details button, a 
Chart Details window will open.  
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The Copy and Paste buttons allow you to move data to and from a Microsoft Excel 
spreadsheet. The Graph button will open a graph of the stress-strain chart including a 
creep curve. For composite conductors, the aluminum, core, and composite curves will be 
graphed along with the composite creep curve. 
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3.5 Tools – Export PLS-CADD® WIR Files (for Concurrent Licenses 
Only) 

Selecting Main Menu toolbar→Tools→Export PLS-CADD WIR Files will open the 
Export PLS-CADD Files screen. This screen will allow you to check off any conductor 
type for which you would like to create a PLS-CADD file directory. Once you have 
chosen all the conductor types you wish, click Generate. The Browse for Folder screen 
will appear. From there, select the directory you would like to store the PLS-CADD files. 
If many conductor types are chosen for export, the export process may yield a busy 
cursor and say “Not Responding”. This is no cause for concern. Please allow the export 
to go through fully before attempting to resume computer activity. 
 
Please see Section 4.3.3 on Generating a WIR file for information about creating single 
PLS-CADD files. 
 
Note: Not all conductor types allow PLS-CADD file creation. 

3.6 Setup Menu 

3.6.1 Print Setup 
Selecting Main Menu toolbar→Setup→Print Setup displays the standard Windows® 
printer setup and selection window. Refer to the Windows User's Guide for details on use 
of Print Setup. 

3.6.2 Page Setup 
Selecting Main Menu toolbar→ Setup→Page Setup opens the SAG10 Page Setup 
screen where you can set page header options. 

 

 
 
First Page 
These header options will appear on the first page of the output only. 
• The Date is checked by default. Uncheck it if you do not wish the date to appear on 

the output. 
• Company Name is a feature that allows you have your company name appear on the 

output. Check the Company Name checkbox and enter your company name in the 
text box.  
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Second Page 
These header options will appear on any subsequent pages of output. 
• Checking Title will cause the text entered in the Title field of the Main Menu to 

appear on subsequent pages. Note that the Title and Description entered on the Main 
Menu always appear on the first page. 

• Checking Conductor Data will cause the description for the conductor to appear on 
all subsequent pages. 

• Checking Date will cause the date to appear on all subsequent pages. 
• Company Name can only be selected if it is selected in the First Page header 

options. 

3.6.3 Fonts 
Selecting Main Menu toolbar→ Setup→Fonts opens the SAG10 Font window. Only 
Fixed Pitch Fonts may be selected. The SAG10 program requires that the Courier New 
font be loaded into Windows. If the proper fonts are not currently installed on your 
computer, refer to the Windows® Control Panel, Fonts for information on loading 
additional fonts. 

3.7 Help Menu 
Selecting Main Menu toolbar→Help in the SAG10 Main Menu tool bar will open a 
submenu with these options:  

• Contents  
• Search for Help On … 
• Tech Support 
• View License 
• About SAG10 [Software] 

 
All of the material in this manual is available in SAG10 Help. 

3.7.1 Help→Contents→Function Tabs  
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Contents 
This tab gives access to a list of SAG10 User’s Manual topics organized in Table of 
Contents order.  

Index 
This tab gives access to the standard Microsoft index feature. 

Find 
This tab gives access to the standard Microsoft word or phrase search feature.  

3.7.2 Help →Search for Help On …  
This tab gives you direct access to the standard Microsoft index feature. 

3.7.3 Help →Tech Support 
This menu item displays contact information for Southwire’s SAG10 technical support.   

3.7.4 Help →View License 
This menu item displays selected licensing information and other information about 
Southwire’s SAG10 software.  

3.7.5 Help →About SAG10 [Software] 
This menu item displays the version number and registration number of the current 
SAG10 program installation.  
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3.7.6 Help →Maintenance Agreement 
This menu item displays the Maintenance Agreement if you currently hold a Maintenance 
Contract. 
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4 Conductor Selection Screen  
To access the Conductor Selection screen, click the Select button in the Conductor 
Selection panel of the SAG10 Main Menu screen.  
 

 
 
The Conductor Selection screen has five main components: 

• The Conductor Type box, where a drop-down menu lets you choose the type of 
conductor to use. 

• The Conductor or Messenger box, where a drop-down menu lets you select a 
specific conductor or support messenger.  

• The Data panel, which shows a data summary for the specific conductor you have 
chosen.  

• The Conductor Options panel, where you can select options for the specific 
conductor you have chosen. Not all options are available for some conductor 
types. 

• The Sort Options menu toolbar which allows you to change the sort options for 
the drop-down list for the Conductor or Messenger box. You can sort By Size or 
By Codeword. 

 
In addition to these five main panels, other panels may appear with additional 
information for a specific conductor type. For example, ACSS conductors are available in 
three different strength options. When you choose an ACSS conductor, a Strength 
Options panel appears, with the available strength options. When you click on a strength 
option, the RBS value in the Data panel automatically updates. 
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4.1 Conductor Type  
This drop-down menu lets you select a construction type. When you choose a general 
construction type, the Conductor or Messenger drop-down menu will display specific 
conductors of that type. Southwire has updated the conductor tables to match current 
ASTM standards, where standards exist.  
 
Some data has been provided by other manufacturers, or is based on legacy values from 
the Alcoa version of the software. Data for these conductors is provided as-is, and should 
be verified as accurate for your particular conductor. 

 
--------------------------------------------------------------------------------------------------------- 

Note 
Standards and manufacturing methods have changed over the years and older 
conductor designs may not exactly match the values in use today. 

--------------------------------------------------------------------------------------------------------- 

Custom Conductor Types  
Any custom conductor types you build and save are stored in a central file that you can 
access by selecting the Custom type in the Conductor Selection drop-down menu. For 
details on creating custom conductors, refer to the Editing Conductor Data section, 
below.  

4.2 Conductor or Messenger 
This is where you select the specific conductor to use, either as a conductor or as a 
support messenger for an assembly. The drop-down list automatically opens when a 
Conductor Type is selected, or you can open the drop-down at any time by clicking on 
the drop-down arrow on the right side of the box. 
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4.3 Chart Type 
This drop-down lets you select a stress-strain chart type. The options are: 
• Legacy – This is historical data based on averages of older individual stress-strain 

test data and calculated data. Stress-strain tests run on these conductors were built 
using various standards. Therefore, your conductor manufacturer should be 
consulted for stress-strain data that is representative of your conductor. 

• Southwire – This option will become available as Southwire releases verified 
stress-strain data. Southwire has instituted a stress-strain testing program in order 
to provide optimal data for the SAG10 software. 

• Manufacturer Verified – This option is for charts representing conductor types not 
manufactured by Southwire. These charts have been verified as representative of 
the conductor by the manufacturer specified under the chart number. 

• Custom – These charts are custom selections by the user. A custom chart could 
include any chart from the Chart Explorer database or one added by the user. If 
the chart selected logically by the SAG10 program is changed, it becomes a 
Custom selection. 

4.4 Data Panel 
Once you select a specific conductor, the data for that conductor will automatically load 
into the conductor Data panel. You will notice there is extra data in SAG10 Version 4.0 
when compared to previous versions. This data is crucial for the application to create the 
PLS-CADD® files available for export. The Chart number specified in the Data panel of 
the Conductor Selection screen is the stress-strain chart found by the SAG10 software 
using the logic in Appendix A: Chart Logic. 
 

 
 

If this is the conductor you want, choose any conductor options you need, then simply 
click the Accept button at the bottom of the Conductor Selection screen to return to the 
Main Menu screen. There are three other buttons in the Data panel that allow you to 1) 
view the stress-strain chart associated with the conductor, 2) edit the conductor data and 
create a custom conductor, or 3) generate a PLS-CADD WIR file for the selected 
conductor (for Concurrent licenses only).   
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4.4.1 View Chart 
The View Chart button in the Data panel will take you to the Chart Details screen and 
show you the stress-strain data assigned to the selected conductor. A unique chart number 
identifies each chart.  

4.4.2 Editing Conductor Data  
The Edit Data button in the Data panel opens the Edit Conductor Info screen, shown 
below, where you can create a custom conductor by modifying the name and 
characteristics of the conductor you’re working with. Conductors that conform to 
CSA/IEC standards may be designed by editing the weights, RBS, and resistances. Note 
that the contents of this screen will change based on the conductor type selected.  
 

 
 
As you edit the data in the Edit Conductor Info screen, the Chart number will change per 
the logic in Appendix A: Chart Logic. If no chart is found using the logic, the Chart field 
will be left blank, whereupon you must fill in this field. Make sure to edit the chart 
number LAST, as the SAG10 program will attempt to find a chart number as you change 
other data fields. You can create a custom conductor by editing the conductor data, then 
clicking Save to Custom. 

• The Accept button will close the screen and retain the modified values for this 
project file only – it will not save them to the conductor database. When re-
opening the project file, this conductor will be available for use in calculations but 
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will not be available in the Conductor Selection screen. A Custom conductor 
must be created for this conductor to be available in the Conductor Selection 
screen. 

• To save your modified values as a Custom conductor, click on the Save to 
Custom button.  

• The Delete Custom button lets you remove custom conductors.  
• The Chart Explorer button takes you to the Chart Explorer screen. Here you can 

review available charts or create a new stress-strain chart. For more details, refer 
to the Tools→Chart Explorer section of the Main Menu chapter.  

4.4.3 Generating a WIR file (For Concurrent Licenses Only) 
The Generate WIR button exports a PLS-CADD® WIR file to the directory you choose.  
Note that all WIR files generated by the SAG10 program are in U.S./Imperial units, 
regardless of the unit selected in the ToolsàOptions menu. 

4.5 Conductor Options 
The Conductor Options box lets you add special features to your conductor selection:  

• VR2® (Twisted Pair) 
• Use as a Messenger 
• Marker Balls 
• PLP Spoiler  

 

 
 

Conductor options that are not available for the selected Conductor Type will appear in 
gray, as is the VR2 (Twisted Pair) option in the example above.  

4.5.1 VR2® (Twisted Pair) Option 
Any of the AAC, AAAC, ACSR, ACSR/AW, ACSR/TW, AAC British, AAAC British, 
or ACSR British conductors may be modeled as a twisted pair conductor. If you select 
the VR2 ( Twisted Pair ) option, the conductor description will indicate use of VR2 by 
appending the “/VR2” suffix to the codeword. 
 
Since VR2 is simply two conductors twisted together, the weights, strength, and areas of 
the wire are doubled. The diameter is considered to be 1.6366 times larger than the single 
conductor for wind and ice calculations. This is due to the cross-section that varies along 
the axis of the line. When this option is selected, a VR2 Equivalent Values panel appears 
with the resulting data to be used. 
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4.5.2 Use as a Messenger 
This option allows you to add several non-supporting cables to a supporting conductor or 
messenger. Each of the non-supporting cables must be of equal diameter and weight. 
 

 
 
In the Additional Weight entry, you can add the weight of additional hardware, such as 
hangers, as an evenly distributed weight. Enter it in lb/ft (kg/m or N/m for Metric). Do 
this by manually summing the total weight of additional attachments, and dividing by the 
total span length. 
 
Hanger Ice Load Factor is a factor added to account for ice buildup on the hangers. 
Determination of the amount of ice is left to the design engineer. The number that has 
traditionally been used, based on 0.50 inches of ice buildup on the hanger, is a value of 
1.8. Southwire does not endorse or recommend this number. For other ice buildup 
thicknesses, enter your calculated value. 
 
The SAG10 program multiplies the weight of a cable by the quantity of cables and adds 
that to the total weight. This total weight is evenly distributed over the span length. 
Radial ice is applied as a uniform layer over each of the cables, as well as the supporting 
messenger. Wind pressure is applied over the cross sectional area of the cables and 
messenger. Radial ice will increase all cable and messenger diameters, and resulting wind 
areas, by twice the radial ice thickness.  

Apply the NESC K Factor 
The NESC K factor can be applied in two ways: Only to Messenger or to Each Cable 
and Messenger. The NESC manual does not clearly define whether the K factor should 
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be applied to the messenger only, or to each of the cables and the messenger, so both 
options have been offered to allow for your discretion.  

Design Limits Apply  
The design limits for messenger-supported assemblies can be applied Before 
Attachment or After Attachment. If you want to apply the design limits to the complete 
assembly, click on the After Attachment button. This will ensure that the design 
conditions are met after installation of cables and additional weights. This approach is 
best used for new lines. 
 
You may also design messenger-supported systems by applying the design limits to the 
messenger only. If you want to apply the design limits to the messenger only, click on the 
Before Attachment button. The sag and tension output will then display two calculations 
per span, the first with the design limits applied to the messenger only, the second to 
showing the effect on the total assembly. This approach allows cables and additional 
weights to be added and analysis to be done for a line that has been up for some time. 
Note that when Before Attachment is used, the NESC limits may be exceeded due to the 
added weight. In some cases, it may be necessary to restring the line. 
 

---------------------------------------------------------------------------------------------------------  
WARNING! 

When you select the Before Attachment option, pay special attention to the two 
calculations per span. It is possible for the first, where the limits are applied to the 
messenger only, to meet all of the design limits, and the second, showing the effect on 
the total assembly, to exceed the bare wire design limits. This method should only be 
used with qualified engineering supervision. 

--------------------------------------------------------------------------------------------------------- 
 
The Supported Cable Information options do NOT apply to the following designs:  
• Any non-supporting cable in direct contact with the messenger, such as figure-8 cable 

or lashed cable. 
• Any pre-assembled non-supporting cable that is strung at the same time as the 

messenger, such as figure-8 cable. 
Calculations for these situations are explained below. 

4.5.3 Non-Supporting Cable, Pre-Assembled or Lashed 
Use this calculation method for non-supporting cables pre-assembled to a messenger 
prior to stringing. 

1. Determine basic information for the messenger, such as area, diameter, weight 
(per foot, or unit of measure), RBS and chart number.  

2. Determine the diameter and weight (per foot, or unit of measure) of the cable(s) 
being supported. 

3. In the Conductor Selection screen, select a Conductor Type for the messenger, 
then a specific conductor to be used as the messenger. 

4. Click Edit Data in the Data panel and enter the Area of the messenger. Enter the 
Weight (per foot, or unit of measure) of the messenger plus cables. For the 



 

SouthwireTM SAG10® Version 4.0.4 User’s Manual [44] 

Diameter, enter the assembly diameter exposed to the wind. Enter the RBS of the 
messenger cable and Chart number for the messenger. 

5. Click Accept or Save to Custom. 
6. You can now use this selection for your sag and tension calculations. 
 

If the cables are in direct contact, such as with lashed cable, the actual amount of 
combined ice build-up will vary depending on the configuration, quantities and diameter 
of the attached cable(s). As a result, all calculations assume the most conservative 
situation: that each cable will be covered with a uniform layer of the radial ice specified 
in the loadings table. If this is too conservative, it is up to the user to calculate an 
appropriate reduction of ice, and then reduce the radial ice indicated in the loadings table 
accordingly. 

4.5.4 Marker Balls  
This option allows you to add marker balls to a conductor. Each of the marker balls must 
be of equal diameter and weight. 
 

 
 
The SAG10 program multiplies the Weight of Ball by the quantity of balls and adds that 
to the total weight. This total weight is evenly distributed over the span length. Radial ice 
is applied as a uniform layer over the balls, as well as over the conductor. Wind pressure 
is applied over the cross sectional area of the balls and conductor. Radial ice will increase 
all diameters, and resulting wind areas, by twice the radial ice thickness.  
 
If marker balls are placed on all the spans within a ruling span, and their weight is evenly 
distributed among all spans, then the results may be obtained using this method. Fill in 
the Data Input for Attachment of Marker Balls prompt screen, using the ruling span 
length, total quantity of marker balls, their individual diameter and weight, and any 
additional weight you may have.  
 
If the marker balls are on a single span within the ruling span, meaning the span is not 
dead-ended on either side, then additional calculations must be performed to determine 
the sag and tension information within that span. For details, refer to Appendices C and D 
in the Appendix section or at www.sag10.com/support/Documentation.htm.   
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When you have selected the Marker Ball option, the marker ball data appears in the 
middle of the sag and tension run, serving as a break between the sag and tension data 
before and after the balls are installed. The second line indicates the quantity of balls, 
span, diameter and weight of one ball, and the additional weight (such as total weight of 
the vibration dampers) as the last item.  

Design Limits Apply 
The design limits for marker balls can be applied Before Attachment or After 
Attachment. If you want to apply the design limits to the complete assembly, click on 
the After Attachment button. This will ensure that the design conditions are met after 
installation of marker balls and additional weights. This approach is best used for new 
lines. 
 
You may also design systems by applying the design limits to the conductor only. If you 
want to apply the design limits to the conductor only, click on the Before Attachment 
button. The sag and tension output will then display two calculations per span, the first 
with the design limits applied to the conductor only, the second showing the effect on the 
total assembly. This approach allows marker balls to be added and analysis to be done for 
a line that has been up for some time. Note that when Before Attachment is used, the 
NESC limits may be exceeded due to the added weight. In some cases, it may be 
necessary to restring the line. 

 
---------------------------------------------------------------------------------------------------------  

WARNING! 
When you select the Before Attachment option, pay special attention to the two 
calculations per span. It is possible for the first, where the limits are applied to the 
conductor only, to meet all of the design limits, and the second, showing the effect on 
the total assembly, to exceed the bare wire design limits. This method should only be 
used with qualified engineering supervision. 

---------------------------------------------------------------------------------------------------------  

Stringing Sag Table Output for Marker Balls 
If you are running a Stringing Sag Table for a line with marker balls, the SAG10 program 
will generate output with the Initial data prior to adding balls, Final data with balls 
attached, and Final loaded data with balls attached. For more information, refer to the 
Stringing Module entry in the section on Output Screen toolbar controls. 

4.5.5 PLP Spoiler  
Click on the PLP Spoiler button in the Conductor Options panel if you want the 
calculations to account for the horizontal and vertical loading created by PLP Spoilers. 
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The Weight/Spoiler is the weight of each spoiler in the 
span. 
 
The Increase in Cond. Diameter is the approximate % 
increase in the conductor diameter due to addition of the 
spoilers. 
 
Once the requested data is filled in, click on the Accept 
button at the bottom of the Conductor Selection screen 
to return to the Main Menu screen. When you run sag 
and tension calculations, the output will show the added 
spoilers and the conductor weight for each load condition 
will include the additional loads created by the spoilers. 
 

Design Limits Apply 
The design limits for PLP spoilers can be applied Before Attachment or After 
Attachment. If you want to apply the design limits to the complete assembly, click on 
the After Attachment button. This will ensure that the design conditions are met after 
installation of PLP spoilers. This approach is best used for new lines. 
 
You may also design systems by applying the design limits to the conductor only. If you 
want to apply the design limits to the conductor only, click on the Before Attachment 
button. The sag and tension output will then display two calculations per span, the first 
with the design limits applied to the conductor only, the second showing the effect on the 
total assembly. This approach allows PLP spoilers to be added and analysis to be done for 
a line that has been up for some time. Note that when Before Attachment is used, the 
NESC limits may be exceeded due to the added weight. In some cases, it may be 
necessary to restring the line. 

 
---------------------------------------------------------------------------------------------------------  

WARNING! 
When you select the Before Attachment option, pay special attention to the two 
calculations per span. It is possible for the first, where the limits are applied to the 
conductor only, to meet all of the design limits, and the second, showing the effect on 
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the total assembly, to exceed the bare wire design limits. This method should only be 
used with qualified engineering supervision. 

---------------------------------------------------------------------------------------------------------  

4.5.6 ADSS Cable 
The SAG10 Conductor Selection panel of the Main Menu includes a selection for ADSS 
(All Dielectric Self Supporting) cable. This feature was written specifically for cable 
manufactured by AFL Global. As such, it requires data that is not typically supplied by 
other cable manufacturers. There are no standard conductor designs available for this 
conductor type. Contact your ADSS cable manufacturer to obtain the information you 
need for this feature.  
 
In order to perform ADSS calculations, first choose ADSS from the Conductor Type 
panel. The Data panel will load with no values, so click on the Edit Data button if it does 
not pop up itself, and type in the proper values requested on the screen. These values may 
be obtained from your ADSS cable manufacturer for your particular cable. Currently, the 
ability to store custom ADSS cable designs is not available. 
 
The MRCL stands for Maximum Rated Conductor Limit and RBS stands for Rated 
Breaking Strength, which is the same as Rated Tensile Strength. It is important that both 
MRCL and RBS values be accurate in order to allow stringing the cable to the proper 
design tensions.  
 
The SAG10 program obtains the allowed percentage of RBS by dividing the MRCL by 
the RBS. This percentage is often 50%, but may range from 45% to 63+%, depending on 
the particular cable. The allowable percentage is increasing as new designs are 
developed.  
 
NOTE: For the breakdown of the sag and tension calculations for an ADSS conductor, 
refer to the paper titled, “ADSS Sag & Tension”. 

4.5.7 OPGW Cable 
The SAG10 Conductor Selection list includes the OPGW (OPtical Ground Wire) type. 
The standard OPGW constructions listed are provided, as is, courtesy of Alcoa Fujikura 
Ltd. (AFL). For information and values for OPGW, contact your OPGW manufacturer. 
 

4.5.8 AAAC Conductor 
The SAG10 Conductor Selection list includes the AAAC (All-Aluminum Alloy 
Conductor) type. The standard conductor tables supplied are for AAAC made from 6201-
T81 aluminum alloy. There are other alloy types that have been, and are currently, being 
used, most notably 5005 alloy. However, 6201-T81 is the only aluminum alloy 
recognized by ASTM for AAAC at this time. 
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4.5.9 ACSR/TW Codewords 
Previous versions of the software identify diameter equivalent trap-wire constructions 
using a TWD suffix rather than the correct codeword.  The codewords for the diameter 
equivalent ACSR/TW conductors have been updated to the new Aluminum Association 
codewords, where they exist. 

4.6 Sort Options 
Once a conductor type has been selected, you can change the sort order for the selections 
in the Conductor or Messenger box drop-down menu from the Sort menu selection on 
the screen toolbar. 

• By Size will cause the SAG10 program to arrange the conductor choices by size, 
from smallest to largest. 

• By Codeword will cause the SAG10 program to arrange the conductor choices 
alphabetically based on the codeword, or the concatenated description for 
products without codewords. 
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5 Edit Loading Table Screen 
In the Load Selection panel of the Main Menu screen, you can choose from a list of 
industry-standard loading configurations.  You should always check these values to be 
sure they are still valid, as standards can change. 
 
If you are using the standard table values, all you have to do is click on a selection in the 
Load Selection panel on the Main Menu screen. However, if you would like to view or 
modify the Load Table, click on the Edit Load Table button in the Load Selection panel. 
The Edit Loading Table screen will appear and, if you have selected one of the standard 
loadings, will pre-load those values into the loading table. If you have selected Custom 
Load Table on the Main Menu screen, a blank table will preload with a single row, 
60.0°F, and Creep in the Usage column for a creep check. Table units and headings are 
based on your selection of Units in the Main Menu→Tools→Options screen. 
 

 
 
The figure above shows a load table with NESC 261.H.1.b EXCEPTION 1 Medium 
values selected. You can make up to a total of 50 additional entries. Once you click 
Accept Loadings, the SAG10 program will automatically sort your entries based on 
conductor temperature. Thus, you can just add them to the bottom of the table. 
 
You can create custom loading tables with the Save As button. Once created, custom load 
files can be selected on the Main Menu screen by checking the Use Existing Load 
Table box. This lets you create a standard load table with the temperatures you need and 
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select it, without having to return to this screen each time you want to use those loading 
conditions. 

5.1 Load Table Fields  
The Load Table fields (columns) are:  

• Conductor Temperature (°F or °C) 
• Radial thickness of ice (inches or mm). The default ice density is 57.0 lb/ft3 for 

glazed ice, per the NESC. Entering a negative value will cause the calculations to 
use the ice density for rime ice (or wet snow). The default density for rime ice is 
37.0 lb/ft3. Both the glazed and rime ice densities can be modified in the Ice 
Density panel on the Edit Loading Table screen. The Ice Density panel has input 
boxes, Save to Defaults buttons for permanent use of edited densities, and a 
Restore Defaults button. 

• Horizontal wind load (lb/ft2, kg/m2, or N/m2). Negative wind values are used as 
total weight per unit length. Negative wind values should not be used when the 
Marker Balls or Use as a Messenger options are selected on the Conductor 
Selection screen. 

• Limit (lb, kg, kN, ft, m, or %RBS). If a negative value is entered, the calculations 
will use the number as a sag limit. Unlike previous versions of the SAG10 
program, if the limit is in %RBS, the number should be input in percentage form, 
not decimal form; e.g. for 33.3 %RBS, you would enter 33.3 instead of 0.333. For 
Metric input, enter this AFTER you switch the Type because the value converts 
based on the Type. 

• Type (lb, kg, kN, ft, m, %RBS). The field specifies the unit for the Limit used. 
• Usage indicates when a condition or limit is to be applied. Options are:  

Initial = Initial Tension or Sag Limit 
Final = Final Tension or Sag Limit 
ET = Elevated Temperature Point 
Creep = 10-Year Creep Check 
CP = Common Point Load 

 
---------------------------------------------------------------------------------------------------------  

NOTE 
The bare weights in the outputs are from the conductor database or a custom 
conductor you create. Loaded weights are calculated by adding the bare weight plus 
the effect of the wind and ice as defined in the load table. 

--------------------------------------------------------------------------------------------------------- 

5.2 Load Selections 
You can quickly load a standard table using the loadings listed in the Load Selection 
panel. Selecting from this list will cause any values currently in the load table to be 
deleted, and the new values loaded. 
 
It is left to you to determine if these values are appropriate and sufficient for the 
conductor selected and the operating conditions. For example, these limits and loads may 
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need to be modified for all-aluminum conductors to prevent vibration, or loading 
conditions may be modified for operating conditions such as extreme ice and wind loads. 

5.2.1 NESC 261.H.1.b 
The 2012 NESC (National Electric Safety Code) Light, Medium, and Heavy loadings for 
overhead conductors are shown in the tables below. Tension limits indicate the maximum 
tensions allowed by the NESC. The 2012 revision to the NESC modified the conductor 
temperatures at which unloaded tension limits apply from 60.0°F for all loading 
conditions to 30.0°F for light loading, 15.0°F for medium loading, and 0.0°F for heavy 
loading areas.  This additional conservatism was added to reduce the probability of 
vibration problems. You should verify these values, as they may change as the NESC 
code is revised. 
 

 
 
You should be familiar with the NESC standard, as there are exceptions and cases where 
it may be inappropriate to apply these limits. 
 
Note that AFL recommends that NESC Limits be reduced to 50.0% for ADSS cables. 

5.2.2 NESC 261.H.1.b Exception 1 
Section 261.H.1.b of the 2012 NESC allows for an exception to the tension limit changes 
for situations where vibration control devices or self-damping conductors are used or 
where an evaluation by a qualified engineer concludes that Aeolian vibration is not likely 
to occur. The SAG10 database includes alternative loading tables for these designs, as 
shown below: 

 

Cond.&
Temp Ice Wind Limit Type Usage Cond.&

Temp Ice Wind Limit Type Usage Cond.&
Temp Ice Wind Limit Type Usage

°F in lb/ft2 %RBS °F in lb/ft2 %RBS °F in lb/ft2 %RBS
30.0 9.00 60.0 % Initial 15.0 0.25 4.00 60.0 % Initial 0.0 0.50 4.00 60.0 % Initial
30.0 35.0 % Initial 32.0 0.25 32.0 0.50
30.0 25.0 % Final 0.0 220.0
60.0 Creep 15.0 35.0 % Initial 0.0 35.0 % Initial
90.0 15.0 25.0 % Final 0.0 25.0 % Final
120.0 15.0 0.0
167.0 30.0 30.0
212.0 60.0 Creep 60.0 Creep

90.0 90.0
120.0 120.0
167.0 167.0
212.0 212.0

NESC&261.H.1.b
Light Medium Heavy

Cond.&
Temp Ice Wind Limit Type Usage Cond.&

Temp Ice Wind Limit Type Usage Cond.&
Temp Ice Wind Limit Type Usage

°F/°C in lb/ft2 %RBS °F/°C in lb/ft2 %RBS °F/°C in lb/ft2 %RBS
30.0 9.00 60.0 % Initial 15.0 0.25 4.00 60.0 % Initial 0.0 0.50 4.00 60.0 % Initial
30.0 32.0 0.25 32.0 0.50
60.0 35.0 % Initial 0.0 120.0
60.0 25.0 % Final 15.0 0.0
60.0 Creep 30.0 30.0
90.0 60.0 35.0 % Initial 60.0 35.0 % Initial
120.0 60.0 25.0 % Final 60.0 25.0 % Final
167.0 60.0 Creep 60.0 Creep
212.0 90.0 90.0

120.0 120.0
167.0 167.0
212.0 212.0

Light Medium Heavy
NESC&261.H.1.b&EXCEPTION)1
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5.2.3 RUS 1724E-200 Table 9-3 
The loading limits specified by the Rural Utilities Service (RUS) are shown in the table 
below. They are more conservative than the NESC limits. If you are designing to RUS 
standards, they should verify what values are correct per the latest RUS documents. 
 

 

 
 

5.2.4 California  
The California Heavy and Light Loadings for Overhead Conductors are shown in the 
tables below. If you are designing to California standards, they should verify what values 
are correct per the latest California standards documents. 
 

 

5.3 Add Gallop Load 
Clicking on the Add Gallop Load button in the Load Selection panel in the Edit Loading 
Table screen will insert the loads shown below into the Load Table. These are required to 
calculate the Galloping Ellipses.  
 

Cond.&
Temp Ice Wind Limit Type Usage Cond.&

Temp Ice Wind Limit Type Usage Cond.&
Temp Ice Wind Limit Type Usage

°F in lb/ft2 %RBS °F in lb/ft2 %RBS °F in lb/ft2 %RBS
30.0 9.00 50.0 % Initial 15.0 0.25 4.00 50.0 % Initial 0.0 0.50 4.00 50.0 % Initial
30.0 33.3 % Initial 32.0 0.25 32.0 0.50
30.0 25.0 % Final 0.0 120.0
30.0 15.0 33.3 % Initial 0.0 33.3 % Initial
60.0 Creep 15.0 25.0 % Final 0.0 25.0 % Final
90.0 15.0 0.0
120.0 30.0 30.0
167.0 60.0 Creep 60.0 Creep
212.0 90.0 90.0

120.0 120.0
167.0 167.0
212.0 212.0

RUS&1724EE200&Table&9E3
Light Medium Heavy

Cond.&
Temp Ice Wind Limit Type Usage Cond.&

Temp Ice Wind Limit Type Usage

°F/°C in lb/ft2 %RBS °F/°C in lb/ft2 %RBS
25.0 8.00 50.0 % Initial 0.0 0.50 6.00 50.0 % Initial
25.0 32.0 0.50
60.0 Creep 320.0
90.0 0.0
120.0 30.0
167.0 60.0 Creep
212.0 90.0

120.0
130.0
167.0
212.0

California
Light Heavy
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---------------------------------------------------------------------------------------------------------  

NOTE 
The NESC, RUS and California Heavy loads already include the gallop load 
conditions. 

--------------------------------------------------------------------------------------------------------- 
 
Refer to the Gallop module section in the Sag & Tension Data screen chapter for more 
information on galloping calculations. 

5.4 Add Creep Load  
To make a standard check for creep, click on the Add Creep Load button in the Load 
Selection panel. The SAG10 program will add a Load Table entry of:  
 

 
 
Any row with Creep in the Usage column will allow the program to check for creep. If all 
such entries are removed, creep will not be checked, and incorrect data may result. In 
such a case, the output will also read Creep is NOT CONSIDERED.  
 
If the final sag is controlled by creep, the output will read Creep governs the final sag. 
If the final sag is controlled by the ice and wind from one of the load cases, the output 
will read Loading conditions govern the final sag. 

5.5 Extra Heavy Loads 
Extra heavy loads, or loads greater than the NESC load, are oftentimes needed for 
consideration in sag-tension calculations. For instance, a utility may want to use a more 
accurate load than the NESC load, or maybe a 1% (once per hundred years) load needs to 
be considered. Whatever the case, these extra heavy loads need to be properly considered. 
When you add an extra heavy load, you want to make sure the structure limits are not 
exceeded. You will need to add a tension limit similar to the one below. 
 

Cond.&
Temp Ice Wind Limit Type Usage

°F/°C in lb/ft2 %RBS
32.0 0.50
30.0

Gallop&Load

Cond.&
Temp Ice Wind Limit Type Usage

°F/°C in lb/ft2 %RBS
60.0 Creep

Creep&Load
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The extra heavy load tension limit will be the Design Condition unless one of the 
standard tension limits is reached first. 

5.6 Use of the Common Point 
A Common Point is used to calculate the sag and tension at an extra heavy load without 
affecting the final sag-tension calculations. This can allow engineers to forecast a 1% 
(once per one hundred years) load without the final sags and tensions taking into account 
the non-recoverable strain from that load, which could potentially create larger sags. 
 
A Common Point may be used at any loading condition by specifying CP in the Usage 
column of the Edit Loading Table screen. If a Common Point needs to be added, but the 
condition already has the Usage column filled, another line may be added with the same 
loading conditions. 
 
Placing a Common Point at a specific loading condition forces the final sag and tension 
calculations to consider ONLY non-recoverable strain from two conditions: the Common 
Point load and creep. That means the non-recoverable strain from all other mechanical 
loads will be ignored, regardless of whether the load is greater or lesser. The non-
recoverable strain at the Common Point loading condition will govern the final sags and 
tensions unless creep yields more strain. 
 
If the calculation uses ACSS conductor, the Common Point condition will always govern 
because ACSS is assumed not to creep. 

5.7 Printing the Load Table 
Saved Loading Table files with a .LOD extension can be opened with a word processor, 
such as Microsoft WordPad or Microsoft Word. Highlight the text and select a fixed pitch 
font such as Courier New. If you want the table headings, you will have to type them in 
manually. When you have chosen your font and headings, print from the word processor.  

Cond.&
Temp Ice Wind Limit Type Usage

°F/°C in lb/ft2 %RBS
0.0 15000 lb Initial

Extra&Heavy&Load
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6 Sag & Tension Data Screen  
 

---------------------------------------------------------------------------------------------------------  
NOTE 

The toolbar in the SAG10 Sag & Tension Data screen offers many important 
project calculation choices. For details, refer to the Data Screen toolbar controls 
section below.  

---------------------------------------------------------------------------------------------------------  

6.1 Data Screen  
When you run sag and tension calculations, either from the Calculate Sag & Tension 
button on the Main Menu screen, or from the Main Menu toolbar→Run menu, the 
SAG10 program generates a Sag & Tension Data screen to display the output. You can 
use the scroll bars to view data that extends off the screen.  
 
If you selected the Pause between Spans option, either in the Ruling Spans panel of the 
Main Menu screen, or in the Main Menu toolbar→Run menu, the toolbar at the top of 
the Sag & Tension Data screen will contain the Next Span option. Clicking on Next 
Span will allow the SAG10 program to calculate each span until the last span is 
displayed.  
 
The SAG10 Main Menu screen toolbar→Tools→Options→Also Output Results to 
panel lets you send sag and tension output to either a printer, or a file, as well as the Sag 
& Tension Data screen when a calculation is run. If you select this, the output of 
calculations for the modules listed in the Sag & Tension Data screen toolbar→Modules 
menu selection: Stringing, Offset Clip, RS Variation, Gallop and Clash are also sent to 
the printer or file.  
 
Refer to the SAG10 Main Menu screen toolbar→Page Setup menu selection for options 
such as adding your Company name and date to the page header. 

6.2 Creep Messages in the Data Screen  

6.2.1 Extrapolated Curve Message 
If your output indicates that the SAG10 program has had to extrapolate a stress-strain 
curve beyond the point where it may be valid, this message will appear. This may happen 
anytime large mechanical loadings are placed on a conductor, particularly in longer 
spans, and very large strains are encountered. The SAG10 program estimates the stress-
strain curve in these situations to the best of its ability and completes the calculation. 
However, you should be aware that this is occurring as it may affect the accuracy of your 
results. 
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6.2.2 Creep Messages and Critical Tension 
• If your output indicates that Creep governs the final sag, it means that final sag 

and tension are controlled by the non-recoverable strain caused by the long-term 
creep of the conductor.  

• If your output indicates that Loading conditions govern the final sag, it means 
that final sag and tension are controlled by the non-recoverable strain caused by 
one of the loaded conditions.  

• If your output indicates that Creep is NOT CONSIDERED, it means that you 
have bypassed the normal creep check by leaving out Creep in the Usage column 
of a temperature case in the Loading Table and that the output is therefore 
potentially incorrect. To add the creep creek, you can click Add Creep Load in 
the Edit Loading Table screen. 

 
For hotter climates, the normal creep check condition at 60.0°F may be changed to a 
higher conductor temperature, such as 70.0°F. Likewise, for a colder climate, the normal 
creep check condition may be changed to a lower conductor temperature, such as 50.0°F. 
The 10-year creep load will be applied at the highest conductor temperature in the 
loading table with a no load, no tension limit and Creep in the Usage column. 
 
The critical tension (Tcr) is the tension corresponding to the intersection between final 
modulus curve and 10-year creep curve in the conductor stress-strain chart.  
 
If T>Tcr, then the 10-year creep curve strain is greater than the final modulus curve 
strain, and the final sag and tension will be based on the 10 year creep curve. The Data 
Screen message will read: Creep governs the final sag.  
 
If T<Tcr, then the 10-year creep curve strain is less than the final modulus curve strain, 
and the Final sag and tension will be based on the final modulus curve. The Data Screen 
message will read: Loading conditions govern the final sag. 

6.2.3 Loading Limits Table 
The limits defined in the loading table will be reported in the output. Limits can include 
tension (directly or in %RBS) or sag. The table will also include any conditions you set 
such as: ET (Elevated Temperature Point), Creep, or CP (Common Point Load). This 
table can allow you to accurately recalculate sag-tension using only this report. 
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6.3 Data Screen Upper Toolbar Controls 
 

 

6.3.1 Action 

Export to Printer 
This menu item displays the standard Windows® printer setup and selection window.  

Export to File 
This menu item saves the report file to a location you specify.  

Set Up Fonts 
This menu item opens the SAG10 Font window. For details, refer to the Main Menu 
screen toolbar→Setup menu section.  

Explore Folder 
This menu item lets you browse for a file or folder location you specify.  

Exit to Main Screen 
This menu item closes the Sag and Tension Data screen and returns you to the SAG10 
Main Menu screen.  

6.3.2 Edit 

Cut, Copy, Paste to Clipboard  
These menu items implement the standard Microsoft Word commands.  

Edit with Wordpad 
This menu item opens Microsoft Word and loads the output report for editing.  

6.3.3 View 

Sag Curves 
This menu item opens the Catenary Curve Parameters window.  
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This window lets you set parameters for the sag curve display.  

Catenary Curve Parameter Window Controls  
• Sag Curve settings for Initial or Final sag 
• Curve Type settings for Catenary or Parabolic curve.  
• Adjustable Horizontal and Vertical scales  
• You can specify a Ground Clearance for the sag curve. If you enter a value of 0, 

no ground clearance will be shown with the sag curve  
• Set a Left Offset for the sag curve to allow better viewing of flatter sag curves.  
• Checking the Show Gridlines box will put gridlines on the screen, printed and 

DXF output. This may aid in alignment of the sag curves with your own grid 
system. 

• You can specify a custom Span Length for the DXF output.  
• The View Graph button opens the Catenary Curve screen. You can print or plot 

the image directly, or transfer it to a graphics program for further editing. Toolbar 
options in the Catenary Curve screen toolbar:  

o Save as BMP file saves the curve to a .BMP file. 
o Print/Plot will send the curve to the default printer or plotting device. 
o Page Setup allows you select print options such as portrait or landscape 

print orientation in a standard Microsoft Word printer setup window.  
o Return takes you back to the Catenary Curve Parameter screen. 

 
• The DXF File button saves the sag file as a .DXF file in a location you specify. A 

DXF file can be imported into most CAD programs. Typical uses would be to 
generate a sag template overlaid with other conductors, or to import the sag curve 
into a drawing containing some ground profile for structure spotting. 
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• The Cancel button closes the Catenary Curve Parameters screen and returns 
you to the Sag & Tension Data screen.  

6.3.4 Stringing Module  
The Stringing Module may be used to make calculations for pulling conductor up to 
sagging tension during installation. The calculation results are the sags for the individual 
spans in a tension section. Selecting this option from the Sag & Tension Data screen 
toolbar Modules list will open the Stringing Temperatures screen.  

 

 

Stringing Spans 
You can enter multiple spans within the ruling span, or select up to 40 individual spans. 
The number of spans times the number of conductor temperatures may not exceed a total 
of 1880.  

Calculate Ruling Span from Span List 
You can also retrieve a span list from a .spn file created and saved in the Ruling Span 
Calculation screen (Refer to the Main Menu toolbar→Run menu section). If this box is 
checked, the SAG10 program will calculate a ruling span for the list of spans used. 

Stringing Temperatures 
The stringing temperatures should be chosen as all the possible conductor temperatures 
on the day of sagging. The appropriate stringing temperature may be found using a 
conductor thermometer on the day of sagging. You can enter up to 30 stringing 
temperatures. The stringing temperatures you enter are independent of the conductor 
temperatures you selected for the normal sag and tension calculation.  
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The stringing temperatures you enter will be retained for the entire SAG10 session, and 
are saved with the project file. 

Condition  
Selecting the Initial condition will calculate initial sags, and selecting Final will 
calculate the final sags. Final W/Load calculates the final loaded sags. 
 
If you have chosen Marker balls or Use as a Messenger in the Conductor Selection 
screen (For more details, refer to the Conductor Selection Screen chapter.), Initial will 
calculate without balls or cables, and Final will calculate with balls or cables attached. 
This will let you string the bare wire before attaching balls and cables, and then check the 
final sag after attachment.  
 
If you are stringing pre-assembled aerial cable, enter the data without balls or cables. The 
Stringing Sag Table will be output as Initial Sag with the attached cable load. (For more 
details, refer to the Conductor Selection Screen chapter.) 
 
Final W/Load will calculate with balls attached. This selection will generate stringing 
sag tables using all of the temperatures with ice or wind loading. 
 
Horizontal tensions are, by definition, the same in all spans within a ruling span section. 
The SAG10 program calculates and stores the horizontal tension for each conductor 
temperature needed in constructing a stringing chart. Stringing sag tables are not 
available when running elevated temperature creep. 

Units 
• The default stringing sag output is ft-in for U.S./Imperial Units.  ft-in allows the 

output to be shown in feet and inches. Inches shows the output in inches only.  
• The setting will default to Decimal for Metric Units. Decimal units are feet for 

U.S./Imperial and meters for Metric. 
• 3rd and 5th Return Wave will generate stringing sag output as the time in 

seconds for sagging done by stopwatch. 
 
For a more concentrated look at the formulas and methods used for stringing calculations, 
go to http://www.southwire.com/transmission/OCM.htm to obtain a copy of the 
Southwire Overhead Conductor Manual. 

6.3.5 Offset Clip Module 
When conductor is strung on steep hillsides it will "run downhill". As a result, the lower 
spans will have more than chart sag and the upper spans will have less than chart sag. 
This difference between chart sag and sag in sheaves can be computed and is given below 
as "sag correction". This sag correction is to be added (+) or subtracted (-) from chart sag 
to obtain the "sag in sheaves". 
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Using the "sag correction" to obtain the "sag in sheaves", the conductor is strung between 
dead-ends or snubbing stations. The correct length of conductor exists between the two 
end points but not in each individual span. The "clipping offset" given below is the length 
of conductor that must be pulled from each span into an adjacent span in order to have 
the correct length at chart sag in all spans. 
 

 
 
All offsets are measured from the intersection of the conductor and a vertical line through 
the point of attachment of the insulator string in its final position. If the structure is 
leaning, the vertical line must be projected from the base of the structure. All offsets must 
be measured before any "clipping in". When the conductor is in suspension clamps, all 
insulator strings will swing plumb. Positive offsets (+) are measured in the direction of 
the first structure, thus the conductor moves ahead on line. Conversely, negative offsets (-
) are measured in a direction away from the first structure in the sagging section.  
 
The SAG10 offset clipping program uses techniques presented in AIEE Paper 59-900, 
"Sag-Tension Computations and Field Measurements of Bonneville Power 
Administration" by Paul F. Winkelman. 

Required Data  
You will need to know the following factors: ruling span, horizontal stringing tension, 
stringing temperature, maximum design tension, loading-ice, wind, conductor 
temperature, bare weight, area and modulus. Many of these factors are already part of the 
SAG10 program.  
 
The program asks for elevation, station and structure number. You must also know the 
direction of pull. The printout produces positive or negative insulator offsets and sag 
corrections by structure number. 

Create a File  
You will need to create a file in a text editor that has ASCII output. Set the file extension 
to .CLP. In the file, each structure will have its own line with the following information, 
in this order, separated by commas:  
• Elevation  
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• Station back 
• Station ahead (Set to 0 if there is no equation station.) 
• Structure identification, enclosed in single quote marks  
 
A sample file called SAMPLE.CLP appears below. The example shows the pull from 
Structure 1-1 to 1-12. Structure 1-6 is a sample of an equation station.  

Sample Clipping Data File (sample.clp) 

 

Offset Clipping Run Procedure  
1. Create a .clp file as described above. 
2. Create and execute a sag and tension run for the ruling span in which the offset 

clipping will be used. 
3. In the Sag and Tension Data screen toolbar, select Modules→Offset Clipping. 
4. A standard Open File window will appear. Select the file you created in step #1. 
5. When you click on Open in the Open File window, the Offset Clipping screen 

will appear.  
 

 
 

The most recently calculated Ruling Span is displayed as the first input. If you 
choose that Ruling Span and a stringing temperature from the most recent Sag and 
Tension run, then the correct Horizontal Tension will be offered as the third input. 

6. Click on the OK button. The Offsets will appear on the Sag & Tension Data 
screen. 

6.3.6 Ruling Span Variation Module 
This module calculates the variation in sags and tensions when spans of differing lengths 
see large temperature excursions.  
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Causes of Sag and Tension Variations  
Between dead-end structures, there are typically a variety of different span lengths. The 
ruling span is a mathematical number that represents a best approximation of the average 
characteristics that will occur within each of those spans. At initial stringing temperature, 
the horizontal tension is the same for all of the spans, assuming the conductor is pulled in 
evenly across the various spans. However, the further the conductor temperature deviates 
from the stringing temperature, and the further a span length varies from the ruling span, 
the greater the variation in sag and tension.  
 
These variations are normally small enough to fall within the safety margin allowed in 
line design. However, at elevated or cold temperatures and with large span variations, 
these variations may be large enough that they should be considered during line design. 
This section allows you to become aware that certain spans may have more sag and other 
spans may have more tension than was calculated by the ruling span sag and tension data 
– and to quantify those differences.  

Calculations are Limited to Suspension Insulators  
These calculations apply only for suspension insulator systems, where the insulators are 
free to swing, limited only by gravity. Fixed insulators, such as post insulators, would 
have less change in sag and tension and are not calculated here. Calculating the exact 
stiffness of the support structure would be required, numbers that would be difficult to 
obtain. 

Running Ruling Span Variations  
To use this module: 

1. Select Modules→RS Variation in the Sag & Tension Data screen toolbar. A 
standard Open File window will open. Select either a .SPN file created in Ruling 
Span Calculations screen or a .CLP file from clipping offset calculations. When 
you click on Open in the Open File window, the Variations in Ruling Span 
Data screen will appear. 

2. Select the correct stringing temperature from the Stringing Temp drop-down 
menu.  



 

SouthwireTM SAG10® Version 4.0.4 User’s Manual [66] 

3. Select the conductor temperature to compare with in the Temp/Load to 
Compare drop-down menu. You can view the extreme variations by selecting an 
elevated temperature, a cold temperature, or an ice load condition for comparison.  

4. Set the comparison condition by clicking on Initial (for cold temperature or ice 
load comparison) or on Final (for elevated temperature comparison).  

5. Enter the length and weight of the entire string of suspension insulators.  
6. Click on the OK button, and the Variations in Ruling Span calculations will 

appear on the Sag & Tension Data Screen.  

6.3.7 Gallop Module 

The SAG10 program will calculate galloping by three methods, the two common 
methods of Davison and Toye, and calculations by C.B. Rawlins, based upon his IEEE 
paper. 

Conductor Galloping Phenomenon 
Galloping has been a problem to operators of overhead lines for decades. Its occurrence 
is largely limited to areas subject to icing of conductors at times when the wind is mainly 
crosswise to the line; more specifically, it is limited to periods of freezing rain when the 
temperature is about 30.0°F. On double circuit lines, it has occasionally been noted that 
the conductors on the leeward side galloped violently, while those on the windward side 
were calm. A few observations have been reported of galloping that occurred on bare 
(free-of-ice) conductors. 
The hazards presented by galloping conductors are: contact between phases, contact 
between phase conductors and ground wires, possible mechanical damage at supports, 
and damage to supporting structures. Mechanical damage at supports is due to the violent 
gyrations of the conductors. Conductor damage can occur at supports due to contact with 
suspension clamps. Conductor damage or trip-outs can occur from contact between 
phases or with ground wires. 
During galloping, the conductors oscillate almost vertically in one or two loops per span. 
The path of the conductor at its antinode is usually an ellipse whose major axis is tipped 
at a small angle to the vertical. In the case of single loops, studies indicate that the major 
axis can be somewhat larger than the sag in the span under loaded conditions, and the 
minor axis can be up to about 40% of this value. It has been noted that single-loop 
galloping rarely occurs in spans over 600 to 700 ft. This is fortunate, since it would be 
impractical to provide clearances large enough in long spans to prevent the possibility of 
contact between phases. 
Observations indicate that in longer spans, galloping usually takes place with two loops 
per span, with the maximum motion of the conductor taking place at the quarter points of 
the span. 
 
The elliptical path of a conductor galloping in a single loop has been studied by A. E. 
Davison, formerly of the Hydroelectric Power Commission of Ontario. Davison's 
diagram shown in the figure below indicates that the elliptical path has a major axis 
inclined to the vertical at a slight angle, and that the entire elliptical path is displaced 
leeward of the point of conductor support. This path of a conductor galloping in a single 
loop is defined by the equations under the diagram. 
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The elliptical paths and a diagram of the clearances for conductors galloping in two loops 
per span have been developed by L. W. Toye, of the Public Service Electric and Gas 
Company of New Jersey. The equations showing parameters of the clearance diagrams 
for the galloping conductors of such spans are given in the right-hand column of the 
figure above. 
 
Since actual galloping of conductors on transmission lines occurs so infrequently and 
usually under bad weather conditions, field observations are scarce, even though the 
phenomenon has been known for a long time. Personal observations have been recorded 
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occasionally, and motion pictures have been obtained, but these have not been 
particularly helpful in the physical study of the prevention or cure of galloping. 
 
Many attempts have been made to apply simulated ice buildups so that normal winds 
might produce consistent galloping effects and the system could be studied at will, but 
here, too, results have been limited. 
 
Stockbridge dampers, known for their ability to control the frequencies encountered with 
Aeolian vibration, are not considered helpful in controlling galloping conductors; the 
dampers may, in fact, be damaged by the galloping. Other methods - most of them 
requiring expensive or impractical devices - have been tried or described, but no effective 
means of prevention is as yet available. 

Add Gallop Loads  
Before you can do galloping calculations, you must have gallop load entries in your load 
file:  

• One line showing 30°F., no ice, no wind  
• One line showing 32°F, 0.50” ice, no wind 
 

Clicking on the Add Gallop Load button in the Load Selection panel of the Edit Load 
Table screen will add these entries to the load table automatically.  

 

Running Gallop Calculations  
Select Modules→Gallop in the Sag and Tension Data screen toolbar and the Galloping 
Data Entry screen will open.  
 
The Galloping Data Entry screen displays current conductor information, applicable sag 
and tension calculation results, and prompts for additional information. 
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Horizontal Span: The displayed value defaults to the current ruling span. This may be 
made larger or smaller, to match specific span lengths within the ruling span. 
 
Suspension Insulator Length: If this value is greater than zero, the Rawlins calculations 
will create a Ymax (peak to peak amplitude) result for suspension structures, and an 
insulator length will be shown in the graphical display. 
 
Structure Spring Constant: This value is used in calculating the Ymax value in the 
Rawlins calculations. The value will vary from the sample entry of 21900 and should be 
determined specifically for your structures. For more details, refer to “Analysis of 
Conductor Galloping Field Observations – Single Conductors” by C. B. Rawlins. 
The Davison and Toye formulas give ellipse dimensions recommended for use in design, 
based on observations available at the time they were published. These dimensions have 
been widely applied in designing clearances for galloping. A more recent, larger 
collection of field observations provides the basis for the Ymax values.  
 
Designers are cautioned that a wide variety of ellipse orientations and eccentricities occur 
in practice. Refer to Fig. 4-6 of EPRI's Transmission Line Reference Book, "Wind 
Induced Conductor Motion" for information on the ranges of variation. 
 

 
 
When you click on the OK button in the Galloping Data Entry screen, the Analysis of 
Conductor Galloping screen opens. This window shows the results of the Davison, Toye 
and Rawlins galloping calculations.  
 
If suspension insulator length prompted for in the Galloping Data Entry screen is set to 
zero, the Rawlins results for suspension insulators will show N/A. If M` has a value, but 
Ymax indicates N/A, it means that the value for Ymax is outside of the range of test data 
available in the galloping study in Rawlins IEEE paper. No input is required for this 
screen.  
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If you click on the OK button in the Analysis of Conductor Galloping screen, the 
Graphic Display of Galloping screen will open.  
 

 
 
To display a graphical layout of the galloping ellipses, you will need to enter two-
dimensional Cartesian coordinates for conductor attachment points. Click on the arrow to 
the right of the Qty of Locations box to select a display of 1 to 4 conductors. An equal 
number of pairs of attachment point boxes will be displayed, (X1,Y1) thru (X4,Y4). 
 
The attachment point furthest to the left and highest in elevation should be considered the 
baseline value of (0, 0). The other attachments are then measured from this point. This is 
to ensure the display is viewable. For optimal scaling, use the Print Scale feature. 
 
An example of properly selecting attachment locations is shown below. 
 

 
 

Above is a plot of the following attachment locations: (0,0) (5,-15) (0,-30). 
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If there is no attachment point that meets the criteria of being in the upper left-hand 
corner, then a layout similar to that shown below should be used. 
 

 
 
Above is a plot of the following attachment locations: (0,-15) (5,-30) (10,0). This layout 
is typical for a 3-phase system on a single pole davit arm or post insulator. 
 
Galloping loops may be graphed as either Single Loop (Davison) or Double Loop (Toye).  
 
Clicking on the DXF File button will open a standard Save As window where you can 
browse for a location to save a DXF file that can be imported into most CAD programs. 
A typical use for this would be to overlay the Galloping Ellipses from more than one 
conductor with the image of a power line structure. 
 
Another use would be for viewing the proximity of ellipses between the conductor and 
OHGW, or to other circuits on the same structure with different conductor or sag 
characteristics. In this case, it is necessary to run sag & tension calculations for each 
conductor or OHGW separately, and generate a separate DXF file for each wire. Each 
DXF file is then imported to a CAD program for overlay upon each other and/or a 
structure drawing. 
 
If you have two dissimilar structures, such as a suspension tangent and a dead-end 
structure, or a horizontal phase layout that rolls into a vertical layout, and you want to 
determine the midspan galloping performance, check the Span Between 2 Dissimilar 
Structures box. The 2nd Structure Attachment Points screen will be added to the 
Graphic Display of Galloping screen.  
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In the example shown above, the first structure is horizontal suspension and the second is 
a vertical dead-end structure. The resulting graphic output is equivalent to two structures 
with attachment points that are an average of the X and Y coordinates of the two 
structures, and an average of the attachment point suspension lengths. 
 
When you click on the View Graph button, the graphic display of the galloping ellipses 
is created.  

 
You can print or plot this image directly, or transfer it to a graphics program for further 
customizing, such as adding to or removing part of the image, setting margins, and/or 
rescaling before printing/plotting. 
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Galloping Graphic Display Toolbar Controls  
 
Print/Plot will send the graphic image to the printer or plotter selected in Print Setup. 
 
Print Setup opens a standard printer setup and selection window. You can select the 
printer or plotter you want to use here.  
 

--------------------------------------------------------------------------------------------------------- 
NOTE 

When returning to the Sag & Tension Data screen, the output will continue to print 
in the direction that was most recently set. Be sure to reset the print direction 
prior to leaving this area to whatever direction may be required for the next 
print operation. 

---------------------------------------------------------------------------------------------------------  
 
Print Scale opens a window that shows the smallest ratio that will fit on the currently 
selected printer/plotter paper. A larger number creates a smaller image. Try a scale such 
as 80:1 for Portrait and 60:1 for Landscape mode for the example shown. 
 
BMP will generate a .BMP file of the graphic screen and open a browser window where 
you can select a file name and a storage location.  

6.3.8 Clash Module  
Clash Analysis refers to the loaded and unloaded swing and static clearances between 
your chosen conductor and ADSS supported on the same structure, for both initial and 
final state. Conductor suspension insulator string length is taken in consideration. The 
steps required are: 

1) Create or Open a project file for the chosen conductor with all the appropriate 
loads and ruling span. 

2) Save the Project. 
3) In the Main Menu toolbar, select Run→Sag & Tension. 
4) In the Sag & Tension Data screen toolbar, select Modules →Clash. 
5) The Clash Analysis Parameters screen will appear indicating that your data has 

been recorded. Click on the Main Menu button to return to return to the Main 
Menu screen to enter the ADSS cable data. 
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6) In the Main Menu, click on the Conductor Selection button. Select the ADSS 
conductor type and click on the Edit Data button in the Data panel. Enter the 
ADSS cable information and click Accept. 

7) Change the Loading Limits (tension or sag) in the Load Table if appropriate but 
leave all loading conditions, both unloaded and loaded, exactly the same. 

8) In the Main Menu toolbar, select Run→Sag & Tension. 
9) In the Sag & Tension Data screen toolbar, select Modules →Clash for a second 

time. A Clash Analysis Parameters screen with spaces for data entry will 
appear.  

 

 
 

10) Adjust the parameters shown on the screen as needed. Be sure to fill in Insulator 
Length if Suspension is selected, and the Horizontal and Vertical offsets 
between the two cables 

11) In the Clash Analysis Parameters window, click on the Report button to view 
the loading cases, cable swing angles, offsets, and conductor to ADSS clearances. 
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12) Click on the Graphic button to view the Clash Diagram screen. This screen 
displays the Transverse and Longitudinal clearances between the two conductors.  
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Options available on the Clash Diagram screen toolbar are: 
Output menu choices: 
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• Output, Print/Plot will send the image to the Printer or Plotter. 
• Output, Print Setup brings up the Printer Dialog box allows the image to be 

rotated to Portrait or Landscape. 
• Output, Scale allows the scale to be adjusted independently for printed output. 

 
View menu choices: 

• View, Long No Load displays a longitudinal view of the conductors under no 
load conditions. 

• View, Long W/ Load displays a longitudinal view of the conductors with ice and 
wind load conditions. 

• View, Transverse displays a transverse view of the conductors under both loaded 
and unloaded conditions. 

• View, Scale allows you to rescale the graphic image to an exact scale. The default 
is Best Fit, which is the largest size that will conveniently fit on the screen. The 
Longitudinal and Transverse Views are scaled separately. 

 
BMP file: 
This will generate a .BMP file of the graphic screen. This graphic image may then 
be stored on disk and/or emailed or otherwise shared as a permanent object. 
 
Return 
This option will close the Clash Diagram screen and return you to the Sag & 
Tension Data screen.  

6.4 Data Screen Lower Toolbar Controls 
 

 

6.4.1 Return 
The Return button closes the Sag & Tension Data screen and returns you to the SAG10 
Main Menu screen. 

6.4.2 Print 
The Print button sends the sag and tension report to the default printer.  

6.4.3 Save 
The Save button opens a standard Save File window where you can choose a file name 
and a location to save the output report file.  
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6.4.4 Copy 
The Copy button opens the default word processor and copies the output report to the 
word processor screen.  

6.4.5 Edit  
The Edit button opens the default word processor and copies the output report to the 
word processor screen for further editing.  

6.4.6 Explore  
The Explore button opens a browser window where you can select a file to open.  
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7 SAG10 Licensed Program End User License Agreement 
IMPORTANT: THIS LICENSED PROGRAM END USER LICENSE AGREEMENT IS 
A LEGAL AGREEMENT BETWEEN THE LICENSEE AND SOUTHWIRE. READ IT 
CAREFULLY BEFORE COMPLETING THE INSTALLATION PROCESS AND 
USING THE LICENSED PROGRAM. IT PROVIDES A LICENSE TO USE THE 
LICENSED PROGRAM AND CONTAINS WARRANTY INFORMATION AND 
LIABILITY DISCLAIMERS. BY INSTALLING AND USING THE LICENSED 
PROGRAM, LICENSEE IS CONFIRMING TO SOUTHWIRE ACCEPTANCE OF 
THE LICENSED PROGRAM AND AGREEING TO BECOME BOUND BY THE 
TERMS OF THIS AGREEMENT. IF LICENSEE DOES NOT AGREE TO BE BOUND 
BY THESE TERMS, THEN SELECT THE "CANCEL" BUTTON TO NEGATE THE 
LICENSED PROGRAM INSTALL. LICENSEE MAY THEN CONTACT 
SOUTHWIRE FOR A FULL REFUND OF THE PURCHASE PRICE LICENSEE PAID 
FOR THE LICENSED PROGRAM. 

7.1 Definitions 
 
(a) “Southwire” means Southwire Company, LLC and its suppliers and licensors, if any. 
 
(b) “Agreement” means, collectively, this SAG10 End User License Agreement and 
Maintenance Agreement.  

 
(c) “Documentation” means the user’s manual and/or other documentation or media 
made available to Licensee along with the Licensed Program, whether in tangible or 
electronic form.   

  
(d) “Licensed Program” means the SAG10 Program and application, including 
Documentation, together with the Updates specified by this Agreement to be supplied as 
part of Maintenance under this Agreement. 

 
(e) “Maintenance” means, collectively, the services to be provided by Southwire as 
stated in the Maintenance Agreement.  
 
(f) “Location” means one or more Licensee-owned or -controlled sites within a single 
city. 
 
(g) “Licensee” means a Person that has been granted a license to use the Licensed 
Program pursuant to the terms of this Agreement. 
 
(h) “Person” means any individual, corporation, partnership, limited liability entity, 
association, or other entity. 
 
(i) “User” means an employee or representative of Licensee or of an Affiliate of 
Licensee, which employee or representative is authorized to use the Licensed Program 
under Licensee’s license. 
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(j) “Update” means a revision, correction, modification, enhancement, addition or 
deletion of a feature to the Licensed Program, some of which may be critical to 
maintaining the integrity of the calculations produced by the Licensed Program. 
 
(k) “Affiliate” means, with respect to any Person, any other Person that controls, is 
controlled by, or is under common control with such Person.  For purposes of this 
definition, “control”, “controlling”, “controlled” and variations thereof mean the 
ownership of more than 50% of the voting ownership interests of a Person or the ability 
to direct the management and policies of such Person.  
 

7.2 License(s) 
 
Licensee may select from the following license options under this Agreement: 
 
(a) Single-User License: Licensee may install and use the Licensed Program on one PC 
or laptop for one (1) User. The license includes one (1) User seat with which the Licensee 
may run the Licensed Program on either a PC or laptop but not on both simultaneously. 
An internet connection is required to register the license to the relevant computer before 
the Licensed Program is first run. An internet connection is required to check out the 
license. Licenses that are checked out will occupy a seat until either: (i) the User checks 
the license back in, or (ii) seven (7) days of inactivity have passed. A Maintenance 
Agreement is required to receive phone/email support and Updates after the initial 30-day 
support period included with purchase of a license. Updates must be done individually for 
each computer on which the Licensed Program is installed. 
 
(b) Basic Concurrent License: Licensee may install the Licensed Program on one PC or 
laptop for each User for use by up to two (2) Users.  Each User may run the Licensed 
Program on either a PC or laptop but not on both simultaneously. An internet connection 
is required to register the license to the relevant computer before the Licensed Program is 
first run. An internet connection is required to check out the license. Licenses that are 
checked out will occupy a seat until either: (i) the User checks the license back in, or (ii) 
seven (7) days of inactivity have passed. A Maintenance Agreement is required to receive 
phone/email support and Updates after the initial 30-day support period included with 
purchase of a license. Updates must be done individually for each computer on which the 
Licensed Program is installed. 
 
(c) Standard Concurrent License: Licensee may install the Licensed Program on any 
number of computers at a Location, but the Licensed Program may be used concurrently 
only by a specific number of Users at that Location based on the number of seats 
purchased. An internet connection is required to register the license to the relevant 
computer before the Licensed Program is first run. An internet connection is required to 
check out the license. Licenses that are checked out will occupy a seat until either: (i) the 
User checks the license back in, or (ii) seven (7) days of inactivity have passed. A 
Maintenance Agreement is required to receive phone/email support and Updates after the 
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initial 30- day support period included with purchase of a license. Updates must be done 
individually for each computer on which the Licensed Program is installed. 
 
(d) Location Concurrent License: Licensee may install the Licensed Program on any 
number of computers at a Location and any number of Users at that Location may use the 
Licensed Program. An internet connection is required to register the license to the 
computer before the Licensed Program is first run. An internet connection is required to 
check out the license. Licenses that are checked out will occupy the seat until either: (i) 
the User checks the license back in, or (ii) seven (7) days of inactivity have passed. A 
Maintenance Agreement is required to receive phone/email support and Updates after the 
initial 30-day support period included with purchase of a license. Updates must be done 
individually for each computer on which the Licensed Program is installed. 
 
(e) Enterprise Concurrent License: Licensee may install the Licensed Program on any 
number of computers owned or controlled by Licensee, regardless of Location, and any 
number of Users may use the Licensed Program. An internet connection is required to 
register the license to the computer before the Licensed Program is first run. An internet 
connection is required to check out the license. Licenses that are checked out will occupy 
the seat until either: (i) the User checks the license back in, or (ii) seven (7) days of 
inactivity have passed. A Maintenance Agreement is required to receive phone/email 
support and Updates after the initial 30-day support period included with purchase of a 
license. Updates must be done individually for each computer on which the Licensed 
Program is installed. 
 
All Concurrent Licenses include the WIR File Creator feature. 
 

7.3 License Restrictions 
 
(a) Licensee may not make or distribute copies of the Licensed Program or electronically 
transfer the Licensed Program from one computer to another or over a network. 
 
(b) Licensee may not decompile, reverse engineer, disassemble, or otherwise reduce the 
Licensed Program to a human-perceivable form. 
 
(c) Licensee may not rent, lease, or sublicense the Licensed Program. 
 
(d) Licensee may permanently transfer all of the Licensee’s rights under this Agreement 
only as part of a sale or transfer of this Agreement to a third party or as part of the sale of 
all or substantially all of Licensee’s assets or ownership interests to a third party, 
provided the Licensee retains no copies, the Licensee transfers all of the Licensed 
Program (including all component parts, Documentation, any upgrades, this Agreement, 
and the product key), and the proposed transferee specifically agrees to the terms of this 
Agreement. If the Licensed Program is an Upgrade, any transfer must include all prior 
versions of the Licensed Program. The Licensee may not sell or transfer any Licensed 
Program purchased under a volume discount. 
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(e) Licensee may not modify the Licensed Program, or create derivative works based 
upon the Licensed Program. 
 
(f) Licensee may not export the Licensed Program into any country prohibited by the 
United States Export Administration Act and all applicable United States export laws, 
rules, and regulations. 
 
(g) In the event that Licensee fails to comply with this Agreement, Southwire may 
terminate the license.  Upon termination of this Agreement, the Licensee must destroy all 
copies of the Licensed Program. 
 

7.4 Upgrades 
 
If this copy of the Licensed Program is an Upgrade from an earlier version of the 
Licensed Program, it is provided to the Licensee on a license exchange basis. The 
Licensee agrees that installing and using the Upgrade constitutes Licensee’s agreement to 
be bound by this Agreement, which will replace and supersede any previous End User 
License Agreement and Maintenance Agreement applicable to such earlier version that 
Licensee agreed upon. The Licensee also agrees that neither it nor its Users will (a) 
continue to use any versions of the Licensed Program preceding such Update nor (b) 
transfer any such Licensed Program to another Person unless prior written consent to 
such transfer has been obtained from Southwire. 
 

7.5 Ownership 
 
The foregoing license gives Licensee a limited license to use the Licensed Program. 
Southwire and its suppliers retain all right, title and interest, including all copyrights and 
other intellectual property rights, in and to the Licensed Program and all its component 
parts, together with all copies thereof. All rights not specifically granted in this 
Agreement, including federal and international copyrights, are reserved by Southwire and 
its suppliers. 
 

7.6 Limited Warranty and Disclaimer 
 
(a) LIMITED WARRANTY. Southwire warrants that, for a period of ninety (90) days 
from the date of delivery of the Licensed Program to Licensee (as evidenced by a copy of 
Licensee’s receipt for purchase of the Licensed Program) when used with a 
recommended hardware configuration, the Licensed Program will perform in substantial 
conformance with the documentation supplied with the Licensed Program.  Southwire 
also warrants that Licensee’s use of the Licensed Program in accordance with the 
Documentation will not result in a breach of any third party copyright, patent, or 
trademark registered in the United States.   
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(b) NO OTHER WARRANTY. EXCEPT AS EXPRESSLY SET FORTH IN THE 
FOREGOING LIMITED WARRANTY, SOUTHWIRE AND ITS SUPPLIERS 
DISCLAIM ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. NO ORAL 
OR WRITTEN INFORMATION OR ADVICE GIVEN BY SOUTHWIRE, ITS 
DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A 
WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THE LIMITED 
WARRANTY SET FORTH HEREIN. 
 
(c) (U.S.A. ONLY) SOME STATES DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO 
LICENSEE. THIS WARRANTY GIVES THE LICENSEE SPECIFIC LEGAL RIGHTS 
AND THE LICENSEE MAY ALSO HAVE OTHER LEGAL RIGHTS THAT VARY 
FROM STATE TO STATE. 
 

7.7 Exclusive Remedy 
 
Without limiting remedies under the Intellectual Property Indemnification provision 
below, Licensee’s exclusive remedy under the Limited Warranty and Disclaimer is to 
contact Southwire through email regarding return of the Licensed Program, and furnish 
Southwire with a copy of the Licensee’s receipt of purchase and a description of the 
relevant Licensed Program defect or nonconformity. Southwire will use reasonable 
commercial efforts to supply Licensee with a replacement copy of the Licensed Program 
that substantially conforms to the Documentation, or refund to Licensee the purchase 
price for the Licensed Program, at Southwire’s option. Southwire shall have no 
responsibility if the Licensed Program has been altered in any way, or if the failure arises 
out of use of the Licensed Program with other than a recommended hardware 
configuration. 
 
If any portion of the Licensed Program becomes the subject of a claim of infringement or 
misappropriation of a U.S. copyright, patent, or trademark, Southwire will either at its 
election: (i) promptly replace such Licensed Program with a substantially compatible and 
functionally equivalent non-infringing product, (ii) promptly modify such Licensed 
Program to make it non-infringing and functionally equivalent to the Licensed Program 
that Licensee initially purchased, (iii) promptly procure for Licensee the right to continue 
using the Licensed Program; or (iv) if none of the preceding three options is 
commercially reasonable, refund all amounts already paid by Licensee to Southwire. 
 
In the event Southwire determines, at any future time, that there is a need to add an 
Update to the Licensed Program that the Licensee possesses, Licensee will be contacted 
by Southwire regarding installation of such Licensed Program with the Update. If 
Licensee refuses to install any Update provided to Licensee, all warranties and remedies 
shall be null and void. 
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7.8 Intellectual Property Indemnification 

Southwire shall indemnify Licensee and its Affiliates and its and their respective 
directors, officers, employees and representatives from and against any damages, costs 
and expenses (including reasonable attorneys’ fees and litigation costs) resulting directly 
from any suit, claim, or proceeding (a “Claim”) alleging that the Licensed Software or 
Documentation infringes a valid registered United States copyright, patent, or trademark 
held by a third party.  Southwire will have no obligation or liability with respect to any 
Claim when:  (a) any Licensed Software or Documentation has been altered, modified, or 
revised (other than by Southwire, at Southwire’s direction, or in accordance with the 
Documentation); (b) without Southwire’s prior written consent, the Licensed Program or 
Documentation has been combined with, operated in connection with, or used with other 
products or services and such combination, operation, or use results in a violation or 
alleged violation of a third party’s intellectual property rights; or (c) Licensee fails to 
implement any Update provided by Southwire at no additional expense, which Update 
could have addressed or abrogated any actual or alleged violation of third party 
intellectual property rights.   
 

7.9 Limitation of Liability 
(a) NEITHER SOUTHWIRE NOR ITS OFFICERS, DIRECTORS, EMPLOYEES, 
REPRESENTATIVES, OR SUPPLIERS WILL BE LIABLE TO LICENSEE OR ANY 
THIRD PARTY FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION DAMAGES 
FOR LOSS OF BUSINESS, LOSS OF PROFITS, OR BUSINESS INTERRUPTION), 
ARISING OUT OF THIS AGREEMENT OR THE USE OR INABILITY TO USE THE 
LICENSED PROGRAM OR THE DOCUMENTATION, AND REGARDLESS OF THE 
THEORY OF LIABILITY ON WHICH SUCH LOSS OR DAMAGES ARE BASED, 
INCLUDING WITHOUT LIMITATION, BREACH OF CONTRACT, BREACH OF 
WARRANTY, TORT (INCLUDING NEGLIGENCE), PRODUCT LIABILITY OR 
OTHERWISE, EVEN IF SOUTHWIRE OR ITS REPRESENTATIVES HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF A REMEDY 
SET FORTH HEREIN IS FOUND TO HAVE FAILED OF ITS ESSENTIAL 
PURPOSE. 
 
(b) WITH THE EXCEPTION OF LIABILITY ARISING UNDER THE 
“INTELLECTUAL PROPERTY INDEMNIFICATION” SECTION ABOVE, 
SOUTHWIRE'S TOTAL CUMULATIVE LIABILITY TO LICENSEE AND 
LICENSEE’S AFFILIATES AND ITS AND THEIR RESPECTIVE DIRECTORS, 
OFFICERS, EMPLOYEES AND REPRESENTATIVES FOR ACTUAL DAMAGES 
FOR ANY CAUSE WHATSOEVER ARISING UNDER THIS AGREEMENT OR USE 
OF THE LICENSED PROGRAM WILL BE LIMITED TO THE GREATER OF $500 
U.S. DOLLARS OR THE AMOUNT PAID BY LICENSEE TO PURCHASE THE 
LICENSED PROGRAM. 
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(c) (U.S.A. ONLY) SOME STATES DO NOT ALLOW THE LIMITATION OR 
EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY 
TO LICENSEE AND LICENSEE MAY ALSO HAVE OTHER LEGAL RIGHTS 
THAT VARY FROM STATE TO STATE. 
 

7.10 Basis of Bargain 

The Limited Warranty, Exclusive Remedies, and Limitation of Liability set forth above 
are fundamental elements of the basis of the agreement between Southwire and Licensee.  
 

7.11 (Outside of the USA) Consumer End Users Only 
 
The limitations or exclusions of warranties and liability contained in this Agreement do 
not affect or prejudice the statutory rights of a consumer, i.e., a Person acquiring goods 
other than in the course of business. 
 

7.12 General Provisions 
 
The internal laws of the State of Georgia shall govern this Agreement, without giving 
effect to such state’s principles on conflicts of laws. This Agreement contains the 
complete agreement between the parties with respect to the subject matter hereof, and 
supersedes all prior or contemporaneous agreements or understandings, whether oral or 
written, regarding such subject matter. All questions concerning this Agreement must be 
directed to: Southwire Company, LLC, P.O. Box 1000, Carrollton, GA 30119, Attention: 
SAG10 Support. 
 

7.13 Third Party Software 
 
Third party trademarks, trade names, product names and logos are the trademarks or 
registered trademarks of their respective owners. 
 
 
©Copyrighted by Southwire Company, LLC, and its Licensors. All Rights Reserved. 
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8 Appendices – Reference Materials 
 
 
 

   
Appendix A – Chart Logic 

 
Appendix B – Error Messages 

 
Appendix C – Determining Sag-Tension on Single Span, 

Original Design Known 
 

Appendix D – Determining Sag-Tension on Single Span, 
No Original Design 
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8.1 Appendix A – Chart Logic 
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Type Cond Stranding Chart Description 

AAC                                                                                                                                              
AAC British                                                                                                                                   
AAC Covered Line Wire                                                                                                                                   
Multiplex (AAC Messenger) 

1 1-764 Legacy 

7 1-918 Legacy 

19 1-945 Legacy 

37 1-1049 Legacy 

61 1-1010 Legacy 

91 1-1157 Legacy 

127 1-1032 Legacy 

    
Type Cond Stranding Chart Description 

AAAC                                                                                                                                          
AAAC British                                                                                                                   
AAAC Covered Line Wire                                                                                                                   
Multiplex (AAAC Messenger) 

7 1-1068 Legacy 

19 1-1056 Legacy 

37 1-1155 Legacy 

61 1-1107 Legacy 

    Type Cond Stranding Chart Description 

Hard Drawn Copper 

1 1-1337 Legacy 

7, 19 1-1239 Legacy 

37, 61 1-1247 Legacy 

    Type Cond Stranding Chart Description 

Alumoweld 

3,7 1-1218 
Legacy or 

Manufacturer 
Verified 

19, 37 1-1140 
Legacy or 

Manufacturer 
Verified 

    Type Cond Stranding Chart Description 

Copperweld 

7 #6 1-1462 Manufacturer 
Verified 

All Others 1-1242 
Legacy or 

Manufacturer 
Verified 

 

Type Type Number Chart Description 

ACSR                                  
ACSR/TW                                     
ACSR/SD                                              
ACSR British                                            
ACSR Covered Line Wire                                     
Multiplex (ACSR Messenger) 

3 1-898 Legacy 

4 1-1053 Legacy 

5 1-1158 Stranding = 
42/7, Legacy 

5 1-1202 Stranding = 
76/19, Legacy 

6 1-844 Legacy 

7 1-1388 Stranding = 
20/7, Legacy 

7 1-1019 

Stranding = 
45/7, Size > 

1510.5 kcmil, 
Legacy 

7 1-957 

Stranding = 
45/7, Size <= 
1510.5 kcmil, 

Legacy 

8 1-1020 Legacy 

ACSR                                  
ACSR/TW                                     
ACSR/SD                                              
ACSR British                                            
ACSR Covered Line Wire                                     
Multiplex (ACSR Messenger) 

9 1-1021 Legacy 

10 1-1277 Legacy 

13 1-815 Stranding = 
6/7, Legacy 

13 1-889 Stranding = 
24/7, Legacy 

13 1-838 Stranding = 
54/7, Legacy 

13 1-1009 Stranding = 
54/19, Legacy 

16 1-537 Size > 762.8 
kcmil, Legacy 

16 1-782 Size <= 762.8 
kcmil, Legacy 

17 1-1023 AWG Size 
smaller than #2 

 

Type Strength Chart Description 

Steel 
HS 1-1245 Legacy 

EHS 1-1293 Legacy 
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Type Type 
Number Chart Description 

ACSR                                  
ACSR/TW                                     
ACSR/SD                                              
ACSR British                                            
ACSR Covered Line Wire                                     
Multiplex (ACSR 
Messenger) 

17 1-938 AWG Size larger 
than #2 

19 1-782 Legacy 

23 1-773 Stranding = 30/7, 
Legacy 

23 1-757 Stranding = 30/19, 
Legacy 

25 1-670 Legacy 

35 1-430 Legacy 

58 1-546 Legacy 

89 1-350 Legacy 

133 1-1166 Legacy 

    Type Type 
Number Chart Description 

ACAR 

13 1-1211 Legacy 

23 1-1203 Legacy 

26 1-1235 Legacy 

27 1-1215 Legacy 

44 1-1223 Legacy 

45 1-1125 Legacy 

54 1-1141 Legacy 

58 1-1196 Legacy 

69 1-1105 Legacy 

75 1-1207 Legacy 

106 1-1206 Legacy 

154 SW-221 Legacy 

13 4-1900 

Stranding = 22/19, 
25/19, 

Manufacturer 
Verified 

 

Type Type 
Number Chart Description 

ACCR 

13 4-1100 

Stranding = 54/19, 
39/19, 

Manufacturer 
Verified 

13 4-1600 
Stranding = 24/7, 

Manufacturer 
Verified 

13 4-1900 

Stranding = 22/19, 
25/19, 

Manufacturer 
Verified 

ACCR 

16 4-1200 

Stranding = 26/7, 
18/7, 

Manufacturer 
Verified 

16 4-1300 

Stranding = 26/19, 
20/19, 22/19, 
Manufacturer 

Verified 

11 4-1400 Manufacturer 
Verified 

ACCR 

23 4-1500 
Stranding = 30/19, 

Manufacturer 
Verified 

23 4-1700 
Stranding = 30/7, 

Manufacturer 
Verified 

17 4-1800 Manufacturer 
Verified 
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Type Type 
Number Chart Description 

ACSR/AW 

3 2-898 Legacy 

4 2-1053 Legacy 

5 2-1158 Stranding = 42/7, 
Legacy 

5 2-1202 Stranding = 76/19, 
Legacy 

6 2-844 Legacy 

7 2-1388 Stranding = 20/7, 
Legacy 

7 2-1019 
Legacy, Stranding 

= 45/7, Size 
>1510.5 kcmil 

7 2-957 
Legacy, Stranding 

=  45/7, Size 
<=1510.5 kcmil 

8 2-1020 Legacy 

9 2-1021 Legacy 

10 2-1277 Legacy 

13 2-815 Stranding = 6/7, 
Legacy 

13 2-889 Stranding = 24/7, 
Legacy 

 

Type Type 
Number Chart Description 

ACSR/AW 

13 2-838 Stranding = 42/7, 
Legacy 

13 2-1009 Stranding = 54/19, 
Legacy 

16 2-537 Legacy, Size > 
762.8 

16 2-782 Legacy, Size 
<=762.8 

17 2-1023 AWG Size smaller 
than #2 

17 2-938 AWG Size larger 
than #2 

19 2-782 Legacy 

23 2-773 Stranding = 30/7, 
Legacy 

23 2-757 Stranding = 30/19, 
Legacy 

25 2-670 Legacy 

35 2-430 Legacy 

58 2-546 Legacy 

89 2-350 Legacy 
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Type Type 
Number Chart Description 

ACSR/AW 

13 2-838 Stranding = 42/7, 
Legacy 

13 2-1009 Stranding = 54/19, 
Legacy 

16 2-537 Legacy, Size > 
762.8 

16 2-782 Legacy, Size 
<=762.8 

17 2-1023 AWG Size smaller 
than #2 

17 2-938 AWG Size larger 
than #2 

19 2-782 Legacy 

23 2-773 Stranding = 30/7, 
Legacy 

23 2-757 Stranding = 30/19, 
Legacy 

25 2-670 Legacy 

35 2-430 Legacy 

58 2-546 Legacy 

89 2-350 Legacy 

 

Type Type 
Number Chart Description 

ACSS 

4 3-949 Southwire 

5 3-949 Stranding = 42/7, 
Southwire 

5 SW-958 Stranding = 76/19, 
Southwire 

7 3-951 Southwire 

8 3-959 Southwire 

9 3-953 Southwire 

10 3-942 Southwire 

13 3-944 Stranding = 24/7, 
Southwire 

13 SW-103 

Stranding = 54/7, 
7 Core Strands, 

Size > 795 kcmil, 
Southwire 

13 3-957 Stranding = 54/19, 
Southwire 

16 3-945 Southwire 

23 3-947 
Stranding = 30/7,           
7 Core Strands, 

Southwire 

23 3-955 Stranding = 30/19, 
Southwire 
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Type Type 
Number Chart Description 

OPGW 

35 1-430 
Legacy or 

Manufacturer 
Verified 

41 1-1441 
Legacy or 

Manufacturer 
Verified 

50-53 1-1438 
Legacy or 

Manufacturer 
Verified 

54-59 1-1439 
Legacy or 

Manufacturer 
Verified 

60-63 1-1455 
Legacy or 

Manufacturer 
Verified 

66-69 1-1170 
Legacy or 

Manufacturer 
Verified 

72-76 1-917 
Legacy or 

Manufacturer 
Verified 

79-83 1-1440 
Legacy or 

Manufacturer 
Verified 

90 1-350 
Legacy or 

Manufacturer 
Verified 

 

Type Type 
Number Chart Description 

ACSS/AW 

4 3-975 Southwire 

5 3-975 Stranding = 42/7, 
Southwire 

5 3-989 Stranding = 76/19, 
Southwire 

7 3-977 Stranding = 20/7, 
45/7, Southwire 

8 3-989 Southwire 

9 3-979 Southwire 

10 3-965 Southwire 

ACSS/AW 

13 3-967 Stranding = 24/7, 
Southwire 

13 3-982 Stranding = 54/7, 
Southwire 

13 3-987 Stranding = 54/19, 
Southwire 

16 3-969 Southwire 

23 3-971 Stranding = 30/7, 
Southwire 

23 3-985 Stranding = 30/19, 
Southwire 

5 3-949 Southwire 
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Type Type 
Number Chart Description 

OPGW 

96-98 1-536 
Legacy or 

Manufacturer 
Verified 

106 1-420 
Legacy or 

Manufacturer 
Verified 

141 1-1166 
Legacy or 

Manufacturer 
Verified 

146-167 1-1461 
Legacy or 

Manufacturer 
Verified 

180-192 1-1450 
Legacy or 

Manufacturer 
Verified 

193-199 1-1457 
Legacy or 

Manufacturer 
Verified 

216-256 1-1453 
Legacy or 

Manufacturer 
Verified 

270-277 1-1421 
Legacy or 

Manufacturer 
Verified 

339-388 1-1442 
Legacy or 

Manufacturer 
Verified 

 

Type Type Chart Description 

Copperweld-Cu 

D 1-1347 
Legacy or 

Manufacturer 
Verified 

A 1-1342 
Legacy or 

Manufacturer 
Verified 

K 1-1360 
Legacy or 

Manufacturer 
Verified 

J 1-1452 
Legacy or 

Manufacturer 
Verified 

F 1-1343 
Legacy or 

Manufacturer 
Verified 

EK 1-1241 
Legacy or 

Manufacturer 
Verified 

E 1-1463 
Legacy or 

Manufacturer 
Verified 
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8.2 Appendix B – Error Messages 
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  Error Message Explanation 

1 
You have NOT Included a Creep Check in Your 
Load Table. The Results May Be Incorrect ! 
Proceed Anyway ? 

Include a Creep condition in the Usage column in the load 
table to allow a creep check. 

2 Could not acquire license. FAILED! NO 
[CONCURRENT] LICENSES AVAILABLE. 

The license you have input is either expired or has no 
available seats. 

3 Could not acquire license. FAILED! INVALID 
LICENSE HOLDER [license #]. 

The license you have input is invalid. Please try a different 
product key. 

4 Cannot Open Conductor DataFile Check the path for the DATA.*files. 

5 Cannot Red Conductor DataFile The DATA.*files were successfully opened, but unable to be 
read. 

6 Conductor Not Found in DataFile The conductor is not available for the specified data type. 

7 No Itype Match in Read Cond File Call tech support. 

8 Cannot Open Sag10.Pgm Make sure that Sag10.Pgm is in the \Sag10 directory. 

9 Cannot Read Sag10.Pgm Sag10.Pgm was successfully opened, but unable to be read. 

10 Cannot Find Chart # The specified chart number is not in the Sag10.Pgm file. 

11 Can't Open Problem File (Open/Save) There was an error in opening the .PRF file. 

12 Cannot Read Problem File The .PRF file was successfully opened, but unable to be 
read. 

13 Opnsav is NOT set to 0 or 1 Call tech support. 

14 Itype 13 in Old PRF File 
The other type has been changed from 13 to 15 in the latest 
version. The problem file should be resaved under Version 
5.1 to update. 

15 S&T Output Buffer Full 

Use the Pause Between Spans option (Main Menu), or 
decrease the number of spans in the Problem file in order to 
view and scroll the output. Does not affect printer or file 
output. 

16 Cannot Open Report File Check for disk space or disk error. 

17 No Tension Limits At least one condition must have a tension limit in the 
Loadings Table. 

18 You have more than one Common Point Only one Common Point is allowed in the Loadings Table. 
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  Error Message Explanation 

19 SIG1 UNDEFINED Initial tension is not defined. 

20 SIG2 UNDEFINED Final tension is not defined. 

21 Can't do ElevTemp & Marker Balls The program cannot calculate both Elevated Temp and Marker Balls options 
at the same time. 

22 Cannot Open .CLP File There was an error opening the .CLP file. 

23 Cannot Read .CLP File .CLP was successful in opening, but unable to be read. 

24 This is the Maximum Number of Values Allowed The limit has been reached for the item mentioned. 

25 The MRCL/RTS ratio may never exceed 60% for ADSS. 
Check your Cable specifications before proceeding! Be sure to use the proper cable specifications. 

26 
The Load Table tension values may NOT exceed the MRCL 
for ADSS Cable. Correct Load Table tension before 
proceeding! 

Set the tension value to less than the cable MRCL. 

27 Error NOT Listed Please contact technical support. 

28 Root#x Failure in Phase#y, where x = 1 to 12 and y = 1 to 12 
The program may fail at any of 12 root calculations (1-12). A typical reason 
for failure is too much load or too big of a span for the strength of the 
conductor. 
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8.3 Appendix C – Determining Sag-
Tension on Single Span, No Original 
Design 
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Situation: A section of line is currently in place, with no recorded data as to the ruling 
span, design limits, or stringing sags. It is necessary to determine the ruling span and 
design limits, in order to modify the line (such as adding marker balls, changing the 
supporting structure, etc.). 
 
For this example, the following assumptions were made: 
 

-­‐ Conductor: 795.0 kcmil 26/7 ACSR “Drake” 
-­‐ Calculated Ruling Span: 1000.00 ft 
-­‐ Loading District: NESC 261.H.1.b EXCEPTION 1 Heavy 
-­‐ Measured Sag: 15.38 ft, 937.00 ft span, 60.0°F conductor temperature 

 
Step #1 
Calculate the ruling span using by inputting all the spans in the applicable tension section 
into the Calculate Ruling Span tool. 
 
Step #2 
Select the conductor in the Conductor Selection screen. 
 
Step #3 
The sag at a given conductor temperature must be determined for at least one span. This 
can be accomplished by measuring the sag with survey methods, or by throwing a ding 
line over the wire and using the stopwatch method (Use proper safety procedures if the 
line is hot). 
 
Step #4 
Choose the applicable load selection in the Load Selection panel on the Main Menu. In 
the Edit Loading Table screen, remove all design limits except for the sag value obtained 
by survey, entered into the Limit column with the distance unit as the Type. Use the 
temperature at time of survey and Final in the Usage column if the line is assumed to be 
at final conditions. 
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Step #5 
Initially, the ruling span value used should match the single span for which the survey 
data was obtained. 
 

 
 
Step #6  
Click the Calculate Sag & Tension button. In the output, note the final tension at 60.0°F. 
This will be your final design limit at 60.0°F in the ruling span sag & tension 
calculations. 
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Step #7 
Create a new project file using the calculated ruling span. The only design limit should be 
the tension obtained in Step #7. When sag & tension are calculated, review the output to 
be sure that design conditions have not been exceeded. 
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8.4 Appendix D – Determining Sag-
Tension on Single Span, Original 
Design Known 
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Situation: Sag & tension information is available for a particular section of line, but 
more information is required for a single span within that ruling span, perhaps to modify 
the line (such as adding marker balls, changing the supporting structure, etc.). 
 
For this example, the following assumptions were made: 
 

-­‐ Conductor: 795.0 kcmil 26/7 ACSR “Drake” 
-­‐ Ruling Span: 1000.00 ft 
-­‐ Loading District: NESC 261.H.1.b EXCEPTION 1 Heavy 

 
Step #1 
Select the conductor in the Conductor Selection screen. 
 
Step #2 
Enter the original design criteria into the loading table. 
 

 
 
Step #3 
Enter the actual ruling span for the section of line. 
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Step #4  
Click the Calculate Sag & Tension button. In the output, note the final tension at 60.0°F. 
This will be your final design limit at 60.0°F in the single span sag & tension 
calculations. 
 

 
 
Step #5 
Create a new project file using the tension obtained above as the only design condition. 
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Step #6 
Use the span length for which further information is requested. For this example, 1134.00 
ft will be used. The sag & tension output will be for the specific span in question, not for 
the ruling span. 
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